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3Введение

Уважаемый слушатель!

Вы начинаете изучение самой популярной среды разработки анимации Adobe Flash CS4 
Professional.  С ее помощью Вы сможете создавать разнообразные, привлекательные, аними-
рованные ролики, которые являются неотъемлемой частью современных профессиональных  
Web-сайтов. 

При изучении данного курса Вам будут полезны навыки работы с такими программами как 
Adobe Photoshop, Adobe Illustrator и CorelDRAW, а также знания основ Web-технологий.

Наш курс состоит из 8 занятий по 4 академических часа каждое. В процессе обучения Вы  
будете не только осваивать теоретический материал, но и выполнять разнообразные практические 
задания. Для закрепления полученных знаний и навыков каждое занятие содержит задания для 
самостоятельного выполнения. Ваша самостоятельная работа – залог успешного освоения курса! 

Следующей ступенью освоения Flash-технологий является изучение языка программирования 
ActionScript.  С его помощью Вы сможете внести интерактивность в Ваши Flash-проекты и 
максимально расширить их функциональные возможности. 

Желаю успеха!
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В учебный комплект включен компакт-диск, содержащий материалы упражнений для  
аудиторной и самостоятельной работы.

Все файлы разделены по занятиям. Материалы каждого занятия находятся в отдельной папке:
lesson_01• 
lesson_02• 
lesson_03• 
lesson_04• 
lesson_05• 
lesson_06• 
lesson_07• 
lesson_08• 

Внутри папки каждого занятия находится папка «Practice_Work», содержащая файлы  
необходимые для выполнения самостоятельных работ. 

В папке «Documentation» находятся официальные руководства по продукту  
Adobe Flash CS4 на русском и английском языках. А так же файл «Links_Flash.doc»,   
содержащий ссылки на полезные Интернет-ресурсы по Adobe Flash.

В папке «Samples» находятся SWF-файлы с примерами готовых flash-роликов.

Что находится на раздаточном диске
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Занятие 1
Продолжительность 180 минут

Темы занятия:

1. Знакомство с редактором Adobe Flash CS4

2. Рисование в Adobe Flash CS4

Занятие 1
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Тема 1. Знакомство с редактором Adobe Flash CS4

О программе

Программа Adobe Flash CS4 является популярной средой для разработки привлекательных, 
анимированных  роликов и �eb-ресурсов. Вы можете создавать графические �лементы непос-�eb-ресурсов. Вы можете создавать графические �лементы непос--ресурсов. Вы можете создавать графические �лементы непос-
редственно в программе Adobe Flash CS4 или импортировать их из других приложений Adobe. 
Вы так же можете легко добавлять в ролик видео и аудио фрагменты.

Основные направления использования Flash-роликов

Можно выделить три основных направления использования Flash-роликов:

1. Flash-ролики для Web. В данный момент �то самое популярное направление. Трудно найти 
сайт, где не использовались бы fl ash-баннеры, меню или заставки. �ольшинство видеосюже-flash-баннеры, меню или заставки. �ольшинство видеосюже--баннеры, меню или заставки. �ольшинство видеосюже-
тов также размещаются в Web в формате flash-видео (flv). Главная особенность таких проектов 
заключается в умении найти оптимальное соотношение между насыщенностью ролика и объ-
емом получаемого файла. По�тому крайне важно уделить внимание вопросам оптимизации  
создаваемых flash-роликов.

2. Flash-презентации. Презентации могут использоваться как на выставках, так и распростра-
няться на CD/DVD дисках. Такие презентации являются яркой, мультимедийно насыщенной 
рекламой конкретного продукта или целой компании. Объемы получаемого файла в данном 
случае не важен, по�тому в данные проекты, как правило, включают высококачественные изоб-
ражения, видео и аудио фрагменты. При создании таких проектов основное внимание уделяется 
красочным спец�ффектам.

3. Flash-приложения. Это может быть аудио-плеер, фото-галерея или целый Интернет-магазин. 
Такие fl ash-проекты могут распространяться как независимые приложения или входить в со-flash-проекты могут распространяться как независимые приложения или входить в со--проекты могут распространяться как независимые приложения или входить в со-
став �eb-страниц. Существенно, что для создания flash-приложений необходимо знание языка 
программирования ActionScript, используемого в среде Adobe Flash. Пожалуй самая популярная 
разновидность flash-приложений - �то flash-игры. Они являются одними из самых трудоемких 
flash-проектов, так как для создания fl ash-игр одновременно требуется высококачественная гра--проектов, так как для создания fl ash-игр одновременно требуется высококачественная гра-flash-игр одновременно требуется высококачественная гра--игр одновременно требуется высококачественная гра-
фика и глубокие знания программирования.  

Инсталляция Adobe Flash CS4

Пакет Adobe CS4 (CS означает Creative Suite) выпускается в следующих вариантах:
•  Adobe CS4 Design Premium
•  Adobe CS4 Web Premium
•  Adobe CS4 Production Premium
•  Adobe CS4 Master Collection

Программа Adobe Flash CS4 входит в состав всех вышеперечисленных пакетов.
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Установка дополнительных программ

Для работы с данным пособием при инсталляции Adobe Flash CS4 необходимо также устано-Adobe Flash CS4 необходимо также устано- Flash CS4 необходимо также устано-Flash CS4 необходимо также устано- CS4 необходимо также устано-CS4 необходимо также устано-4 необходимо также устано-
вить следующие дополнительные программы:
•  Adobe Media Encoder CS4
•  Adobe Device Central CS4
•  Adobe AIR Player

Системные требования

•  Процессор 1 ГГц и выше
• Microso�t� Windo�s� �P с пакетом Service Pac� � либо Windo�s Vista� �ome Premium, Busi-Microso�t� Windo�s� �P с пакетом Service Pac� � либо Windo�s Vista� �ome Premium, Busi-� Windo�s� �P с пакетом Service Pac� � либо Windo�s Vista� �ome Premium, Busi-Windo�s� �P с пакетом Service Pac� � либо Windo�s Vista� �ome Premium, Busi-� �P с пакетом Service Pac� � либо Windo�s Vista� �ome Premium, Busi-�P с пакетом Service Pac� � либо Windo�s Vista� �ome Premium, Busi- с пакетом Service Pac� � либо Windo�s Vista� �ome Premium, Busi-Service Pac� � либо Windo�s Vista� �ome Premium, Busi- Pac� � либо Windo�s Vista� �ome Premium, Busi-Pac� � либо Windo�s Vista� �ome Premium, Busi- � либо Windo�s Vista� �ome Premium, Busi-Windo�s Vista� �ome Premium, Busi- Vista� �ome Premium, Busi-Vista� �ome Premium, Busi-� �ome Premium, Busi-�ome Premium, Busi- Premium, Busi-Premium, Busi-, Busi-Busi-
ness, Ultimate или Enterprise с пакетом Service Pac� 1 (сертифицировано для �2-разрядных ОС 
Windo�s �P и Windo�s Vista)
•  1 Гб оперативной памяти
•  �,5 Гб свободного пространства на жестком диске для установки; дополнительное свободное 
пространство, необходимое для установки (не устанавливается на съемные диски)
•  Разрешение монитора 1024x768 (рекомендуется 1280x800) с 16-разрядной видеокартой
•  Привод DVD-ROM
•  Программное обеспечение Quic�Time 7.1.2, необходимое для мул ьтимедийных функций
•  Широкополосное интернет-соединение, необходимое для онлайн-услуг

Оптимизация производительности 

В процессе создания анимации интенсивно используется оперативная память компьютера. Про-
грамма Adobe Flash CS4 минимально требует 1 Гб оперативной памяти, но чем больше памяти 
будет доступно, тем быстрее будет работать данное приложение.

Официальная справка и поддержка

Русскоязычная страница продукта:
http://���.adobe.com/ru/products/flash/

Страница поддержки продукта (содержит ссылки на примеры, help-файлы, и т.п.):
http://���.adobe.com/support/flash/

Ресурс, содержащий примеры и расширения от компании Adobe и сторонних разработчиков:
http://���.adobe.com/go/exchange_ru

Русская справка по ActionScript (on-line):
http://help.adobe.com/ru_RU/Flash/10.0_Welcome/index.html

В электронном виде эти и другие полезные ссылки находятся на раздаточном диске:
Documentation\Links_Flash.doc
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Стартовое окно программы

При запуске программы Adobe Flash CS4 по умолчанию открывается стартовое окно, которое 
разделено на три колонки:

Open a Recent Item (Открыть последние) В �той колонке будет накапливаться список тех фай-
лов, с которыми Вы работали последними. Чтобы открыть произвольный файл необходимо на-
жать кнопку Open (Открыть)

Create New (Создание нового файл). Создавая новый файл, Вы должны сразу выбрать его тип:

•  Flash File (ActionScript �.0)
•  Flash File (ActionScript 2.0)
•  Flash File (Adobe AIR)

При выборе одного из данных типов, будет создан новый 
FLA файл и установлены соответствующие настройки 
публикации

•  Flash File (Mobile) Создание проектов для мобильных устройств
•  Flash Slide Presentation
•  Flash Form Application

Создание FLA файла с использованием �кранов (Screen) 
для создания презентаций, слайд-шоу и форм

•  ActionScript File
•  ActionScript Communication File
•  Flash JavaScript file

При выборе одного из данных типов, будет создан новый 
файл скриптов

•  Flash Project Создание проекта, облегчает синхронизацию большого 
числа FLA-файлов, файлов скриптов и �TML-страниц

Create from Template (Создание из шаблона). Создавая файл из шаблона, Вы получите новый 
файл с заданным размером ролика и настройками публикации.

Создание файлов

В нашем курсе мы в основном будем работать с файлами «Flash File (ActionScript 2.0)» и  
«Flash File (ActionScript 3.0)». Выбор правильной версии языка ActionScript крайне важен, 
так как во-первых, программные коды �тих двух версий несовместимы. То есть код, напи-
санный для ActionScript 2.0,  нельзя выполнить под ActionScript �.0 и наоборот. А во-вторых, 
некоторые инструменты (трехмерная трансформация и обратная кинематика) доступны толь-
ко в проектах, созданных для ActionScript �.0. 

После того, как файл уже создан, изменить используемую версию языка ActionScript можно с 
помощью команды File > Publishing Settings. Для �того на закладке Flash в списке Script нуж-
но выбрать необходимую версию языка. Однако, если flash-ролик содержит сценарии, может 
потребоваться их изменение, по�тому рекомендуется определить версию языка в момент 
создания файла и не менять ее в процессе работы. 

Форматы файлов

FLA-файлы – �то основные файлы, с которыми работает программа Falsh. Они содержат муль-Falsh. Они содержат муль-. Они содержат муль-
тимедийные объекты ролика, временные шкалы и скрипты (сценарии) ActionScript. 

Мультимедийные объекты – �то графические (растровые и векторные), текстовые, аудио и ви-
део объекты, которые входят  в состав ролика. Временная шкала – �то место, где при создании 
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ролика, вы указываете программе Flash какие объекты в какой момент времени должны отоб-Flash какие объекты в какой момент времени должны отоб- какие объекты в какой момент времени должны отоб-
ражаться в рабочей области ролика. Скрипты или сценарии ActionScript могут быть добавлены 
внутрь FLA-файла или располагаться в отдельном файле скрипта. Они позволяют программно 
управлять объектами flash-ролика и их взаимодействием с пользователем.

SWF-файлы – �то скомпилированные flash-ролики, предназначенные для просмотра.

Flash-ролики могут быть воспроизведены:
•  В Интернет-браузерах с установленным плагином Adobe Flash Player или Active� Flash.
•  С помощью приложения Adobe Flash Player.
•  С помощью программ Flash �tra в продуктах Director и Author�are корпорации Adobe�.
•  С помощью �лемента управления Active� Flash в Microso�t O�fice и других приложениях с 
поддержкой Active�.
•  В составе фильма Quic�Time.
•  В качестве автономного приложения, которое называется проектором.

Кроме того flash-ролики могут быть опубликованы, как AIR-приложения.

Интерфейс редактора

Закладки открытых
документов

Рабочая область
ролика (Stage)

Свернутые группы палитр
(Icon Panels)

Главное меню
программы

Временная шкала
(Timeline)

Выбор рабочего
пространства

Резвернутая палитра
Properties (Свойства)

Палитра Tools
(Инструменты)
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Главное меню программы содержит иерархический список всех доступных команд. 

Все мультимедийные объекты, которые входят в состав ролика, располагаются в рабочей об-
ласти (Stage). По умолчанию можно видеть все содержимое, добавленное в ролик, вне зави-
симости от того помещается ли оно в размеры рабочей области ролика или находится за ее 
пределами. Чтобы видеть содержимое только в пределах рабочей области ролика необходимо 
отключить функцию Vie� >Pasteboard (Вид > Монтажный стол).

Временная шкала (Timeline) содержит слои и кадры. По мере воспроизведения ролика кадры 
временной шкалы последовательно сменяют друг друга. В процессе создания анимации мы по-
мещаем мультимедийные объекты в разные слои и в нужных кадрах изменяем их свойства.

Создавать новые графические объекты или трансформировать имеющиеся можно с помощью 
палитры Tools (Инструменты).

Палитра Properties  (Инспектор свойств) предназначена для изменения основных свойств 
выделенного объекта или для изменения настроек выбранного в данный момент инструмента.

Для управления другими свойствами объектами объектов предназначены различные палитры.

Работа с палитрами и настройка «Рабочего пространства»

Управление палитрами осуществляется через меню Windo�. Открытые в данный момент па-
литры отмечаются галочками. Палитры можно сворачивать (Icon Panels) или оставлять в раз-
вернутом виде. Можно группировать палитры в «полки» и легко управлять шириной сразу всех 
палитр, добавленных в данную полку.

Палитры можно расположить наиболее удобным образом и сохранить собственное рабочее 
пространство с помощью команды Windo� > Wor�space > Ne� Wor�space.

Палитра History (История) располагается в группе Other Panels (Другие панели).
Скрыть все панели - F4

Особенности интерфейса Adobe Flash CS4

Пожалуй, главное новшество в интерфейсе Adobe Flash CS4  - �то вертикально расположен-
ный инспектор свойств (палитра Properties), он теперь разделен на секции, которые можно при 
необходимости сворачивать. Это позволяет более �ффективно использовать рабочее пространс-
тво на широкоформатных мониторах.

Числовые значения в большинстве палитр теперь можно изменять с помощью мыши.  
Достаточно щелкнуть в поле ввода значения и, не отпуская левую кнопку, переместить мышь 
вправо (значение увеличивается) или влево (значение уменьшается).

Улучшена палитра Library (�иблиотека). В нее добавлена функция поиска и возможность на-
значения свойств сразу нескольким ресурсам.

В соответствии с расширением функциональных возможностей Adobe Flash CS4 добавлены 
новые инструменты и палитры.
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Управление файлами

По умолчание файлы в редакторе Adobe Flash CS4 открываются в виде закладок (Tab).  
Если щелкнуть по имени файла и переместить его из панели файлов, то данный файл будет 
отображаться в отдельном окне, которое можно свернуть или развернуть на весь �кран (при 
�том он закроет все палитры). 
Если в файле есть не сохраненные изменения рядом с именем файла отображается звездочка.

Основные настройки редактора Adobe Flash CS4

Доступ к основным настройкам редактора Adobe Flash CS4 можно получить с помощью коман-Adobe Flash CS4 можно получить с помощью коман- Flash CS4 можно получить с помощью коман-Flash CS4 можно получить с помощью коман- CS4 можно получить с помощью коман-CS4 можно получить с помощью коман-4 можно получить с помощью коман-
ды Edit >Preferences (Редактирование > Настройки). Слева списком располагаются катего-
рии настроек:
•  General (Общие настройки)
•  ActionScript (Настройка стилей отображения кода)
•  Auto �ormat (Автоформатирование скриптов ActionScript)
•  Clipboard (Настройка буфера обмена)
•  Dra�ing (Настройки рисования)
•  Text (Настройки подстановки отсутствующих шрифтов)
•  Warning (Настрой предупреждений)
•  PSD File Importer (Настройка импортирования PSD-файлов)
•  AI File Importer (Настройка импортирования AI-файлов)

В категории General (Общие) доступны следующие наиболее важные настройки:
On launch (При запуске) Указывает, какой документ откроется при запуске приложения

Undo (Отмена):
•  Document-level Undo (Отмена на уровне документа) – при �том пишется единая история 
изменений для всех объектов, входящих в документ. 
•  Object-level Undo (Отмена на уровне объекта) – при �том для каждого объекта записывается 
независимая история изменений и можно отменять действия с объектом, не затрагивая измене-
ний в других объектах.

Levels – число операций, которые можно отменить.

С помощью команды Edit > Customize Tools Panel (Редактирование > Настройка панели инс-
трументов) можно по-своему расположить и сгруппировать инструменты на панели Tools.

Для ускорения работы используются сочетания «горячих клавиш». Изменить их можно с  
помощью команды Edit > Keyboard Shortcuts (Редактирование > Сочетания горячих клавиш). 
В верхней части окна располагается список выбора набора сочетаний (Current Set). Чтобы 
настроить собственные сочетания клавиш, нужно сдублировать наиболее подходящий набор  
(с помощью команды Duplicate Set), внести необходимые изменения в набор и нажать 
кнопку OK.
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Основные параметры flash-ролика

Доступ к основным параметрам ролика можно получить с помощью команды Modi�y > Docu-Modi�y > Docu- > Docu-Docu-
ment (Изменить > Документ):

•  Dimensions – Размеры рабочей области ролика
•  Match – Рассчитать под:
 Printer (размер выбранной бумаги в принтере, который установлен по умолчанию)
 Content (размер всех объектов, которые помещены в ролик в данный момент)
 De�ault (размер по умолчанию 550 x 400 px)

•  Background color – Фоновый цвет ролика
•  Frame rate – Частота воспроизведения кадров ролика. Измеряется в �ps (�rames per second) – 
количество кадров в секунду
•  Rules unit – Единицы измерения

Также свойства документа отображаются на палитре Properties (Инспектор свойств),  
если выбран инструмент Selection Tool (Выделение), но ни один объект не выбран.  

В ролик можно внедрить подробные метаданные, с помощью команды File > File Info  
(Файл > Информация о файле).

Тестирование ролика

Чтобы протестировать созданные ролик необходимо выполнить команду Control > Test Movie 
(Управление > Тестировать ролик). При �том в той же директории, где находится исходный 
FLA-файл, будет создан SWF-файл, которой будет воспроизведен в среде разработки Flash.

Сочетание горячих клавиш для этой команды CTRL + ENTER. 

Работа со слоями

Слои, как и в любом графическом редакторе, располагаются столбцом. Тот слой, который нахо-
дится выше других, закрывает собой содержимое нижележащих слоев. Изменять порядок слоев 
можно перемещая их с помощью мыши. Слои можно помещать в папки, перетаскивая их в пап-
ку или из нее с помощью мыши. Переименование слоев – двойной щелчок по имени слоя. 

Ниже списка слоев расположены управляющие кнопки:
•  Ne� Layer (Создать новый слой)
•  Ne� Folder (Создать папку)
•  Delete (Удалить)
 
Рядом с именем каждого слоя отображаются три столбца с управляющими маркерами.  
Первый столбец отвечает за видимость слоев, второй – за блокировку, а третий – за тип отобра-
жения (только контур или контур с заливкой). 

Над каждым столбцом отображается следующие значки:
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Sho� or �ide All Layers (Показать / скрыть все слой)

Loc� or Unloc� All Layers (�локировать / разблокировать все слой)

Sho� All Layers as Outlines (Показать содержимое всех слоев в виде контуров)

Чтобы, например, скрыть один слой нужно щелкнуть мышкой по маркеру-точке напротив его 
имени в первом столбце. Чтобы заблокировать все слои, кроме данного, нужно щелкнуть по 
соответствующему маркеру-точке с нажатой клавишей ALT.

Чтобы получить доступ к настройкам слоя, нужно щелкнуть по нему правой кнопкой мыши 
и выбрать из контекстного меню пункт Properties (Свойства). При �том можно изменить тип 
слоя, выбрать цвет контуров, отображающих слой в режиме Outlines и настроить высоту слоя.

В правой верхней части палитры Timeline (временная шкала) находится кнопка вызова допол-
нительных настроек палитры . С ее помощью можно настроить ширину отображения кад-
ров на временной скале 

Обзор палитры Tools (Инструменты)

Инструменты разделены на группы. Рядом с именем каждого инструмента в круглых скобках 
указана  «горячая» клавиша. Внизу палитры Tool находится область настроек, которая позво-
ляет управлять параметрам и режимами выбранного инструмента. Расширенные настройки 
инструментов располагаются на палитре Properties (Инспектор свойств).    
           

Инструменты трансформации и выделения

Инструменты рисования и ввода текста

Параметры и режимы выбранного инструмента

Инструменты управления

Инструменты помощники

Выбор цвета обводки контура

Выбор цвета заливки контура
установить цвета заливки и обводки по умолчанию
поменять местами цвета заливки и обводки
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Тема 2. Рисование в Adobe Flash CS4

Все фигуры, созданные в редакторе Adobe Flash, являются �лементами векторной графики. Для 
описания контуров используются кривые Безье. Контур состоит из опорных точек и сегмен-
тов. Если сегмент контур криволинейный, то его к его опорным точкам добавляются управля-
ющие точки, которые отвечают за кривизну данного сегмента. Чем дальше управляющая точка 
отстоит от опорной, тем сильнее изгиб контура. Каждый контур обладает заливкой и обводкой.

Режимы рисования 

В редакторе Adobe Flash используется три режима рисования: 

Режим слияния
В �том режима программа Flash соединяет все нарисованные фигуры там, где они наклады-
ваются друг на друга. Если фигуры имели одинаковый цвет заливки, они сливаются в единую 
фигуру. Если цвета заливки были разными, при попытке разделить �ти фигуры происходит как 
бы вычитание одного контура из другого

Режим объектов
В �том режиме программа Flash автоматически не соединяет нарисованные объекты. Они ос-
таются разделенными даже когда перекрываются. Чтобы включить режим рисования объектов, 
нужно выбрать один из инструментов рисования и в области настроек (внизу палитры Tools) 
включить опцию Object Drawing (Рисование объектами)

Типы опорных точек

Структура векторного контура (кривой Безье)  
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Режим примитивов
Во Adobe Flash CS4 существует два инструмента, которые могут создавать примитивы – �то 
Rectangle Primitive Tool  и Oval Primitive Tool. В отличие от обычных объектов, примитивы 
позволяют изменять параметры формы уже после того, как форма нарисована. 

Для инструмента Rectangle Primitive Tool  
можно в любой момент изменить радиусы 
скругления углов нарисованного прямо-
угольника. 

Для Oval Primitive Tool можно управлять 
внутренним диаметром и положением на-
чального и конечного угла сегмента.

Инструменты рисования:

Rectangle Primitive Tool Oval Primitive Tool 

К группе инструментов рисования в Adobe Flash CS4 относятся:

•  Группа инструментов Pen (Перо):
 Pen Tool – рисование контуров произвольной формы
 Add Anchor  Point Tool – добавление опорной точки
 Delete Anchor  Point Tool – удаление опорной точки
 Convert Anchor  Point Tool – изменение типа опорной точки (гладкая или угловая)
•  Text Tool – инструмент для ввода и редактирования текста
•  Line Tool – рисование прямых линий
•  Группа инструментов для рисования примитивов:
 Rectangle Tool – рисование прямоугольников
 Oval Tool – рисование овалов
 Rectangle Primitive Tool – рисование прямоугольников в режиме примитивов
 Oval Primitive Tool – рисование овалов в режиме примитивов
 PolyStar Tool – рисование многоугольников и звезд

•  Pencil Tool (Карандаш) – рисование обводок произвольной формы
•  Группа кисти:
 Brush Tool (Кисть) – рисование заливок произвольной формы
 Spray Brush Tool (А�рограф) – инструмент для хаотического распределения символов
•  Deco Tool (Декорирование) – инструмент для симметричного расположения символов, созда-
ния отражений и заполнения областей выбранным символом 
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Так как программа Adobe Flash CS4 в основном предназначена для создания анимации, инс-Adobe Flash CS4 в основном предназначена для создания анимации, инс- Flash CS4 в основном предназначена для создания анимации, инс-Flash CS4 в основном предназначена для создания анимации, инс- CS4 в основном предназначена для создания анимации, инс-CS4 в основном предназначена для создания анимации, инс-4 в основном предназначена для создания анимации, инс-
трументы рисования не столь разнообразны, как в специализированных редакторах. Удобнее 
создавать все графические �лементы в таких редакторах как Adobe Illustrator, Adobe Photoshop 
и импортировать их внутрь flash-ролика.

Параметры инструментов рисования

Для инструментов, создающих обводку контура (Pen Tool, Line Tool и Pencil Tool), на палитре 
Properties (Инспектор свойств) можно установить:
•  Цвет обводки
•  Толщину обводки
•  Стиль обводки (сплошная линия, пунктир, точки и т.д.) Если выбрать команду Edit Stroke 
Style можно изменять параметры стиля обводки контура
•  Свойство (�inting), которое заставляет программу Flash располагать опорные точки контура 
так, чтобы их координаты по осям � и Y имели целочисленные значения в пикселях. 
•  Выбрать форму скругления на концах лилии (Cap) и в местах стыка сегментов контура (Join) 
Для инструмента Pencil Tool также можно выбрать степень сглаживания (Smoothing).

Для всех других инструментов, которые создают контур, обладающий и обводкой и заливкой, 
кроме вышеперечисленных параметров можно изменять цвет заливки контура.

Для инструмента Brush Tool (Кисть) внизу палитры Tools (Инструменты) можно выбрать:
•  Режим рисования (Brush Mode)
•  Размер кисти (Brush Size)
•  Форму кисти (Brush Shape)
Размер штриха, оставляемого инструментом кисть, зависит от масштаба просмотра. 
Т.е. кисть с одним и тем же размером при уменьшение масштаба будет оставлять более крупный 
штрих. А при увеличении масштаба – штрих получиться более тонким.

Для инструментов Rectangle Tool и Rectangle Primitive Tool на палитре Properties (Инспектор 
свойств) можно изменять радиус скругления углов. 
Для Oval Tool и Oval Primitive Tool можно настроить внутренний радиус и значения улов сег-
мента. Если выбрано свойство Close path (Замкнутый контур), то сегмент будет нарисован с 
заливкой и обводкой. Если �то свойство отключено (галочка снята), то будет нарисован только 
контур без заливки.

Чтобы настроить параметры инструмента PolyStar Tool необходимо выбрать команду Options 
(Опции), которая расположена в секции Tool Settings (Настройки инструмента) палитры Prop-
erties (Инспектор свойств). При �том можно указать:
•  Тип создаваемой фигуры многоугольник (polygon) или звезда (star)
•  Количество сторон (или лучей)
•  Для звезд можно установить параметр Star Point Size, который отвечает за длину лучей.

Инструменты а�рограф и декорирование будут рассмотрены позднее.

Инструмент Eraser Tool (Ластик) позволяет удалить части контура, созданного в режиме слия-
ния или объектного рисования. Внизу палитры Tools можно выбрать:
•  Режим стирания (Eraser Mode) - режимы аналогичны режимам рисования кисти
•  Опция Faucet (Кран) - позволяет стирать участки прямых между точками пересечения
•  Форму и размер листика (Eraser Shape) 
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Инструменты выделения

В программе Adobe Flash CS4 есть следующие инструменты выделения:

Selection Tool
Выделение объектов целиком. Выделенный объект можно перемещать и изменять его свойства 
с помощью панели Properties (Инспектор свойств). Чтобы выделить несколько объектов, необ-
ходимо щелкнуть по ним, удерживая клавишу SHIFT. Если подвести данный инструмент к сег-
мента контура, нарисованного в режиме слияния, то можно изменять форму данного сегмента.

Внизу палитры Tools у данного инструмента есть опция Snap to Objects (привязка к объектам). 
Если она включена, то при перемещении выделенного объекта, он автоматически выравнива-
ется относительно других объектов ролика. Чаще это опция удобна, но иногда она может 
помешать правильно позиционировать объекты (в этом случае ее нужно отключить). 

Subselection Tool
Выделение опорных точек контура. Выделенную точку можно перемещать или изменять поло-
жение связанных с ней управляющих точек.

Lasso Tool
Выделение областей произвольной формы. Применяется только к контурам, нарисованным в 
режиме слияния. Выделенный фрагмент контура можно перемещать или изменять его свойства 
с помощью панели Properties (Инспектор свойств).

Группировка объектов

Нарисованные или импортированные графические объекты можно объединять в группы.  
Для их необходимо выделить и выполнить команду Modify > Group. Сочетание «горячих»  
клавиш CTRL+G. Одноименная команда также доступна из контекстного меню.

Заливка и обводка контура

Вы можете установить нужный стиль заливки (Fill) и обводки (Stroke) до рисования контура. 

Если объект уже создан, то чтобы изменить заливку или обводку нужно:
•  Либо выделить один или несколько объектов и изменить нужные значения на палитре Proper-
ties (Инспектор свойств). 
•  Либо не выделяя объекты, изменить значения на палитре Properties, выбрать соответству-
ющий инструмент Paint Bucket Tool (Заливка – изменяем свойства заливки объектов) или  
Ink Bottle Tool (Чернильница – изменяет свойства обводки) и щелкнуть выбранным инструмен-
том по тем объектам, стиль которых необходимо изменить.

Инструмент Eyedropper Tool (Пипетка) позволяет скопировать стиль с одного объекта на дру-
гой. Стили заливки и обводки копируются раздельно. Т.е. если щелкнуть инструментом  
Пипетка по заливке контура, то будет скопирован только стиль заливки. При �том инструмент 
изменит свой вид на инструмент заливки (Paint Buc�et Tool) и, щелкая им по другим объектам, 
вы будете применять к ним новый стиль заливки, а обводка объектов останется прежней.
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Типы заливки и обводки контура. Панель «Color»

Расширенные настройки заливки и обводки находится на панели «Color» (Цвет).
В редакторе Adobe Flash поддерживаются следующие типы заливок и обводок:

None
Без заливки. Если применить данный тип заливки к контуру, нарисованному 
в режиме слияния – заливка будет удалена и изменить ее в дальнейшем будет 
не возможно. Для контуров, нарисованных в режимах объектов и примитивов, 
заливка не удаляется и ее можно изменять.
Solid 
Сплошной (однородный) цвет. Чтобы выбрать нужный цвет можно:
•  Указать значение цветовых составляющих по каждому из каналов
•  Ввести шестнадцатиричный код цвета «hex code» (например, #660099)
•  Выбрать цвет на цветовой палитре и отрегулировать его яркость 
Для каждого цвета можно установить значение прозрачности Alpha
Linear
Линейный градиент

Чтобы добавить новый цветовой переход, нужно 
щелкнуть по полосе градиента. При �то будет со-
здан новый маркер цвета. Чтобы удалить какой-ли-
бо маркер цвета, его необходимо выделить и выта-
щить из полосы градиента.

Чтобы создать градиент, совместимый с масшта-
бируемой векторной графикой (SVG), установите 
флажок «Linear RGB». Благодаря этому градиент 
будет выглядеть ровнее при последующих измене-
ниях масштаба

Radial
Радиальный градиент

Bitmap
Растровое изображение. В качестве образца растровой заливки может приме-
няться любое растровое изображение, помещенной во flash-ролик. Внизу па-
литры Color будет отображаться список, всех доступных изображений.
Чтобы добавить новое изображение можно выполнить команду Import  
(Импортировать) на палитре Color.

Для линейного и радиально градиентов также доступно свойство Overflow (Переполнение).
Результат заметен только, когда градиентный переход меньше площади контура:

По умолчанию во Flash используется цветовая модель RGB. Так же поддерживается модель 
HSB. Выбрать нужную цветовую модель можно из меню дополнительных опций палитры 
Color (данная кнопка расположена в верхнем правом углу палитры). 

Чтобы добавить созданный стиль заливки или обводки в образцы нужно выполнить команду 
Add Swatch (добавить образец) из меню дополнительных опций палитры Color.
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Трансформация заливки

Для того чтобы изменить параметры градиентного переходи и растровой заливки предназначен 
инструмент Gradient Transform Tool (Трансформация градиента). Этот инструмент не изменя-
ет форму контура, он действует только на его заливку.

Для инструментов Brush Tool (Кисть) и Paint Bucket Tool (Заливка) внизу палитры Tools до-Tools до- до-
ступна опция Lock Fill (Заблокировать заливку). Если �та опция включена и выбран градиент-
ный стиль заливки, то все контура создаваемые кистью или закрашенные инструментов заливка 
будут управляться единым градиентом. Если данная опция отключена, то для каждого объ-
екта будет создаваться новый (независимо управляемый) градиент.

Линейный градиент
поворот

поворот

пропорциональное
масштабирование

пропорциональное
масштабирование

масштабирование
по одной оси сдвиг по одной оси

центр градиента

смещение относительно
центра градиентаРадиальный градиент

Растровая заливка
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Импортирование растровых изображений

Импортировать растровое изображение можно с помощью команд File > Import > Import to 
Stage или Import to Library.  Разница между ними состоит в том, что команда Import to Li- to Li-to Li- Li-Li-
brary помещает изображение только в библиотеку ролика, а команда Import to Stage сразу по-
мещает копию изображения в рабочую область ролика. В любом случае изображение попадает 
в �иблиотеку ролику (Library). Разместить изображение из библиотеки можно просто пере-
тащив его в рабочую область ролика. Для ускорения можно перетащить нужный графический 
файл в рабочую область прямо из файлового менеджера. 

Если к растровому изображению применить команду контекстного меню Break Apart  
(Разделить), то его можно применять в качестве растровой заливки просто щелкнув по нему 
инструментом Eyedropper Tool (Пипетка) и «закрасив» нужный объект.

Практическая работа

Все файлы, необходимые для выполнения данной работы, находятся на раздаточном диске в 
папке «lesson_01\Practice_Work_1»

Задание 1. Обрисовка по фотографии

1. Создайте новый Flash-ролик (Flash File ActionScript 2.0) и установите для него размеры рабо-
чей области 800 х 500 px.

2. Импортируйте в рабочую область ролика файл moto.jpg.

�. Установите для изображения координаты х = 0 px, y = 0 px и заблокируйте данный слой от 
изменений.

4. Создайте новый слой, в нем используя различные режимы рисования (режим слияния, режим 
объектов и режим примитивов) обрисуйте мотоцикл по фотографии. 

Можно рисовать все в одном слое, используя группировку или режим рисования объектами, а 
можно создавать новые слои для различных частей. Это зависит только от Вашего желания. 

Раскрасьте мотоцикл с помощью палитры Color. Наиболее красиво смотрятся градиентные за-
ливки, которые позволяют передать объем объекта.

Пример выполненного задания: sample_blue.swf и sample_red.swf



Продолжительность 180 минут

Темы занятия:

Занятие 2

1. Управление объектами 

2. Понятие символов
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Исходный объект
Перспективная трансформация

с помощью инструмента
Free Transform Tool 

точка трансформации

Тема 1. Управление объектами 

Трансформация объектов

Для трансформации объектов в редакторе Adobe Flash CS4 можно воспользоваться инструмен-
тами трансформации, группой команд Modify > Transform (Модификация > Трансформа-
ция) или палитрой Transform (Трансформация).

Так же с помощью палитры Properties (Инспектор свойств) можно изменять положение объекта 
на рабочей области (X и Y) и размеры объекта: W (�idth) – ширина объекта, H (height) – высота. 
Чтобы объект масштабировался пропорционально нужно щелкнуть по знаку цепи расположен-
ному рядом с данными параметрами.

К инструментам трансформации относятся:
•  Free Trans�orm Tool (Свободная трансформация)
•  �D Rotation Tool (Поворот в в трехмерном пространстве)
•  �D Translation Tool (Масштабирование в трехмерном пространстве)

3D Rotation Tool и 3D Translation Tool можно применять только к клипам. Подробна работа 
с этими инструментами будет рассмотрена на занятии 5.

Инструмент Free Transform Tool (Свободная трансформация) позволяет перемещать, мас-
штабировать, поворачивать, сдвигать, искривлять объекты и создавать зеркальные отраже-
ния. Поворот объекта осуществляется относительно точки трансформации (белый кружок).  
С помощью инструмента Free Transform Tool можно изменить положение �той точки.

Внизу палитру Tools есть ряд дополнительный опций данного инструмента:
•  Rotation and Skew (только поворот и сдвиг)
•  Scale (только масштабирование)
•  Distort (искривление)
•  Envelope (нелинейной искажение) 
Параметры Distort и Envelope применимы только к контурам, созданным в режиме слияния 
или объектов (т.е. не применим к примитивам).

Полезные клавиши:

Пропорциональная трансформация – SHIFT
Поворот на 45 градусов и перемещение только вдоль осей координат – SHIFT
Масштабирование и сдвиг от точки трансформации – ALT

Временное переключение инструмента 
Free Transform Tool в режим Distort 
(искривление) – CTRL

Перспективная трансформация 
(два противоположных угла объекта 
симметрично сдвигаются навстречу 
друг другу) – CTRL + SHIFT
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Из меню Modify > Transform доступны все вышеперечисленные трансформации. Дополни-
тельно доступны команды поворота на 90 градусов и зеркального отражения:
•  Flip Vertical (отражение по вертикали)
•  Flip Horizontal (отражение по горизонтали)

С помощью палитры Transform (Трансформация) можно изменить:
•  Размеры объекта (Scale Width и Scale Height). Чтобы объект масштабировался пропорцио-
нально нужно щелкнуть по знаку цепи расположенному рядом с данными параметрами.
•  Угол поворота (Rotation). Положительные значения соответствует вращению объекта по ча-
совой стрелке, отрицательные – против.
•  Сдвиг по горизонтали и вертикали (Skew). Отрицательные значения будут создавать зеркаль-
ные отражения объекта.

Чтобы сбросить параметры трансформации (пока трансформация объекта не завершена) 
нужно нажать кнопку Remove Transform (Удалить трансформация), расположенную в нижнем 
правом углы палитры Transform.

Кнопка Duplicate Selection and Transform, расположенная там же, позволяет дублировать вы-
бранный объект и применять к нему последние значения трансформации.

Изменение порядка следования объектов

Чтобы изменить порядок следования объектов, расположенных в одном слое, применяют груп-
пу команд Modify > Arrange (Модификация > Упорядочить). Одноименные команды также до-
ступны из контекстного меню, когда выбран какой-либо контур или объект:
•  Bring to Front – сделать объект самым верхним
•  Bring Forward – переместить объект на одни уровень вверх
•  Send Backward – переместить объект на одни уровень вниз
•  Send to Back – сделать объект самым нижним
•  Lock – заблокировать объект (при �том объект нельзя выделить)
•  Unlock all – разблокировать все объекты

Выравнивание и распределение объектов

Для выравнивания и распределения объектов предназначена палитра Align (Выравнивание).  
В правой части �той палитры находится опция To Stage, если она включена, то выравнива-
ние и распределение объектов производится относительно размеров рабочей области ролика.  
Если данная опция отключена, то объекты выравниваются меду собой.

Исходный объект

масштаб 80%, поворот 10O масштаб 90%, поворот 10O

Результаты трансформации
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Описание палитры Align (Выравнивание)

Разница между командами Distribute и Space 
заключается в том, что команда Distribute 
выравнивает промежутки между геометри-
ческими центрами объектов, а команда Space 
выравнивает промежутки между самими 
объектами.

Распределение объектов по слоям 

Для создания анимации в большинстве случаев требуется, чтобы в одном слое находился только 
один объект. Если в одном слое нарисовано несколько объектов программа Flash может авто-
матически распределить их по слоям. Для �того необходимо выделить все объекты, которые 
должны быть распределены и выполнить команду Modify > Timeline > Distribute to Layers 
(Модификация > Временная шкала > Распределить по слоям). 
Для ускорения работы эту же команду можно вызвать из контекстного меню. 

При �том будет автоматически создано столько слоев, сколько было выделено объектов, и в 
каждом слое будет находиться только один объект.

Работа с объектами

Контур, нарисованный в режиме рисования объектами (Object Drawing) можно преобразовать 
к простым контурам так, как будто он был создан в режиме слияния. Для �того его необходимо 
выделить и выполнить команду Modify > Break Apart (Модификация > Разделить).

Чтобы выполнить обратное преобразование, то есть объединить контур, созданный в режиме 
слияния, в объект рисование, необходимо выполнить команду  Modify > Combine Object > 
Union (Модификация > Комбинированные объекты > Объединить). 
Данное преобразование не применимо к группам (Group).

Если выделены два контура, созданные в режиме объектного рисования, то к ним можно приме-
нить команды пересечения и объединения объектов Modify > Combine Object:

Выравнивание
по вертикали

Распределиние
по вертикали

Выравнивание
по горизонтали

Распределиние
по горизонтали

Выравнивание
промежутков между 
объектами

Опция привязки
к размерам
работчей 
облисти ролика

Выравнивание
размеров объектов

(по большему)
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Трассировка растровых изображений 

Чтобы преобразовать растровое изображение в векторные контура (трассировать изображение) 
необходимо выделить данное изображение и применить команду  Modify -> Bitmap -> Trace 
Bitmap (Модификация > Растровое изображение > Трассировать). 

При �том нудно указать следующие параметры: 
•  Color threshold. Пороговое значение цвета. При увеличении �того значения число цветов в 
получаемом изображении снижается.
•  Minimum area. Наименьший участок. Задает число соседних пикселов, которые учитывают-
ся при назначении цвета данному пикселю.
•  Curve fit. Точность контура. Влияет на плавность обрисовки контура
•  Corner threshold. Пороговое значение угла. Указывает смягчать или нет резкие углы изобра-
жения.

Управление формой контура

При масштабировании объектов и контуров, значе-
ние толщины обводки контура не изменяется. Из-за 
�того при сильном уменьшении объекта обводка ста-
новиться слишком толстой, а при увеличении объек-
та наоборот слишком тонкой. Чтобы избежать проблем 
при масштабировании объектов применяют команды  
Modify > Shape > Convert Lines to Fills (Модификация > 
Форма > Конвертировать обводку в заливку).

Можно также смягчить границы контура, применив 
команду Modify -> Shape -> Soften Fill Edges (Моди-
фикация > Форма > Смягчить края заливки). При �том 
обводка контура удаляется и создается указанное число 
дополнительных заливок с равномерно уменьшающейся 
прозрачностью. 

Параметры команды Soften Fill Edges:
•  Distance – общая ширина создаваемого перехода
•  Number of steps – число шагов (заливок)
•  Direction – направление:
 Expand – наружу,  Inset - внутрь

Результат команды 
Modify > Combine Object
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Чтобы создать векторное изображение максимально похожее на исходное растровое изображе-
ние введите следующие значения:
•  Color threshold = 10
•  Minimum area = 1 pixel
•  Curve fit = Pixels 
•  Corner threshold = Many corners (много углов)

Однако, если исходное изображение было достаточно сложным (много деталей и цветов), про-
цесс трассировки может быть крайне долгим, а векторное изображение получиться настолько 
сложным, что даже производительный компьютер будет работать с ним не приемлемо долго.

Тема 2. Понятие символов

Символы в программе Adobe Flash выполняют две основные задачи: 
• Позволяют уменьшить размеры получаемого flash-ролика
• Упрощает процесс создания сложных роликов

Символы необходимо использовать для тех мультимедийных объектов, которые используются 
в ролике несколько раз. При �том полная информация об объектах, помещенных символ, за-
писывается один раз и называется Эталоном символа. Эталоны хранятся в библиотеке ролика 
(Library). При использовании символа в ролик помещаются его Экземпляры, которые являют-
ся просто ссылками на �талон данного символа. 

По�тому когда Вы используете символы, размер ролика практически не зависит от числа ис-
пользуемых �кземпляров. К тому же сильно упрощается процесс внесения изменений - до-
статочно изменить эталон символа, и �ти изменения будут автоматически применены ко всем 
�кземплярам данного символа.

Создание символов

Есть два пути создания символов - можно создать новый символ, а можно конвертировать в 
символ объекты, которые уже размещены в рабочей области ролика.

Создание нового символа
Чтобы создать новый символ необходимо нажать кнопку New Symbol (Новый символ), распо-
ложенную в нижнем левом углу палитры Library (�иблиотека). 
При �том появиться диалоговое окно для ввода параметров символа:

Имя эталона символа
Тип символа

Каталог
можно сразу создать 

каталог в библиотеке,
куда будет помещен

данный символ Дополнительные параметры символа
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После того, как параметры символа определены, программа Flash перейдет в режим редакти-
рования эталона - отобразится новая временная шкала и пустая рабочая область, на которую 
Вы можете помещать любые объекты, которые должны быть включены в данный символ. 

После то, как Вы разместили все нужные объекты 
необходимо просто выйти из режима редактирова-
ния �талона и все изменения будут сохранения. 

Для �того нужно на палитре Edit Bar (Редактиро-
вание) нажать кнопку Scene 1 (Переход к главной 
временной шкале ролика) или кнопку перехода на 
один уровень вверх. 

По умолчание палитра Edit Bar располагается сра-
зу под палитрой Timeline.

Важно, что при создании нового символа создается только эталон символа, который хранить 
в библиотеке (Library). Чтобы разместить символ в ролике, нужно выделить его в палитре 
Library и перетащить в рабочую область ролика. При �то будет создан экземпляр данного сим-
вола. Только экземпляры символов могут отображаться в ролике, а эталоны лишь хранят 
полное описание.

Конвертирование объектов в символ
Часто возникает потребность преобразовать в символ объекты, которые уже размещены в 
ролике. Для �того необходимо выделить на рабочей области ролика все нужные объекты и вы-
полнить команду Modify > Convert to Symbol (Модификация > Конвертировать в символ). Эта 
команда также доступна из контекстного меню. «Горячая» клавиша для �той команды F8.

При �том возникает диалоговое окно для указания параметров символа аналогичное тому, что 
появляется при создании символа. За исключение одно нового параметра – положение точки 
регистрации символа (Registration): 

Эта точка указывает положение начальной точки осей координат внутри данного символа. 

Палитра Etit Bar

Переход к главной временной 
шкале ролика (Scene 1)

Переход на один уровень вверх

При конвертировании объектов в символ программа Flash автоматически не переходит в режим 
редактирования �талона, но �талон с указанным именем создается в библиотеке ролика (Li-Li-
brary). Все выделенные объекты помещаются внутрь созданного символа. Важно, что при �том 
создается и эталон символа и один экземпляр, который сразу размещается в ролике.

Управляющие точки символов

У каждого символа есть две управляющих точки:

Точка регистрации (обозначается перекрестием)
Показывает положения начала координат (x = 0, y = 0) внутри данного символа. Это связано с тем, 
что в редакторе Flash используется локальная система координат. То есть координаты объек-
тов, расположенных внутри символа отсчитываются не от левого верхнего угла рабочей области  
(как на главной временной шкале ролика), а от точки регистрации данного символа. 
Положение точки регистрации задается один раз для эталона символа. 
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Точка трансформации (обозначается белым кружком)
Точка, относительно которой происходит трансформация экземпляров данного символа  
(например, поворот). Положение �той точки можно задать индивидуально для каждого �кзем-
пляра символа с помощью инструмента Free Transform (Свободная трансформация).

Работа с библиотекой символов «Library»

В библиотеке ролика содержатся все ресурсы, помещенные в ролик (�талоны символов, графи-
ческие изображения, аудио фрагменты и т.д.). Для удобства ресурсы библиотеки можно поме-
щать в каталоги. Доступен поиск по имени ресурса. 

Чтобы разместить ресурс в рабочей области ролика, его нужно выделить в окне �иблиотеки и 
просто переместить с помощью мыши в нужное место рабочей области. Редактирование �тало-
на символа - двойной щелчок по области просмотра.

Внешний вид палитры Library (�иблиотека) представлен на рисунке:

Если у Вас открыто несколько документов Flash (FLA-файлов), то Вы можете легко копировать 
ресурсы из одного документа в другой. Для �того с помощью кнопки New Library Panel нужно 
открыть новую палитру �иблиотеки. В ней в поле выбора документа указать другой файл из 
числа открытых в данной момент. Теперь Вы можете копировать ресурсы просто перетаскивая 
их мышью из одной �иблиотеки в другую. Также можно открыть новое окно �иблиотеке друго-
го ролика выполнив команду File > Import > Open External Library. 

Список всех
ресурсов

ролика

Создать
новый символ

Новый каталог

Свойства ресурса

Удалить выделенные
ресурсы

Количество
ресурсов

Выбор
документа

Просмотр
выделенного

ресурса

Тип ресурса
Дата и время 
последнего изменения

Количество копий (экземпляров)
использованных с ролике

Парамерт для управления средствами Action Script

Поиск

Открыть
новую
палитру
Библиотеки
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Типы символов

В программе Adobe Flash существует три типа символов: 

•  Movie Clip (Клип) предназначены для хранения фрагментов анимации
•  Graphic (Графический символ) в основном предназначены для хранения �лементов, внутри 
которых не содержится собственной анимации (например, растровых изображений)
•  Button (Кнопка) �лемент позволяющий сделать ролик интерактивным. Работа с �тим типом 
символов будет рассмотрена на занятии 6.

Каждый символ имеет собственную временную шкалу. Внутри символов можно размещать 
либо статические мультимедийные объекты, либо создавать анимацию. Так же внутрь одних 
символов можно помещать другие символы. Например, Вы можете создать клип для панели 
навигации, а внутрь эталона этого клипа вложить экземпляры символов-кнопок. 

Самым гибким типом символов являются клипы. По�тому в некоторых flash-проектах ис-
пользуют только �тот тип символов.

Отличия графических символов и клипов

Внутрь графических символов можно помещать анимацию, при �том она  будет зависима от 
главной временной шкалы. То есть в ролике будет воспроизводиться только то количество кадров 
внутренней анимации, сколько кадров временной шкалы занимает сам графический символ.

Временная шкала клипов независима от главной шкалы – �то дает большую гибкость при 
разработке ролика. То есть анимация, расположенная внутри клипа может идти асинхронно с 
главной временной шкалой ролика.

Графические символы имеют следующие ограничения:
•  Временная шкала графического символа зависима от главной временной шкалы.
•  Внутрь графических символов нельзя помещать аудио фрагменты
•  К �кземплярам графических символов нельзя применять фильтры и режимы наложения
•  Экземплярами графических символов нельзя манипулировать в трехмерном пространстве
•  Экземплярами графических символов нельзя управлять с помощью языка программирования 
ActionScript и �талоны �тих символов не могут содержать сценарии ActionScript
 
Параметры экземпляров

Для изменения свойств �кземпляров в программе Flash предназначена палитра Properties  
(Инспектор свойств). Положение и параметры трансформации также можно изменить с по-
мощью соответствующих инструментов и палитры Transform. 

Для каждого экземпляра символа можно изменить:

•  Положение на рабочей области (Для графических символов и кнопок только координаты по 
осям � и Y, для клипов так же положение по оси Z)
•  Трансформацию (масштаб, угол поворота, сдвиг)
•  Настроить Color Effect (Цветовой �ффект) на палитре Properties
Только для графических символов:
•  Настроить в секции Looping как должна воспроизводиться анимация данного символа:
Loop (циклически), Play Once (один раз), Single Frame (единичный кадр).
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Только для клипов и кнопок:
•  В секции Display палитры Properties можно настроить режим наложения (Blending)
•  Установить параметр Cache as Bitmap (к�шировать как растровое изображение), который 
позволяет ускорить и улучшить отображения данного символа, если символ не подвергается 
трансформации
•  В секции Filters можно управлять фильтрами, примененными к данному �кземпляру.

Color Effect (Цветовой эффект) 

Чтобы применить к выделенному �кземпляру цветовой �ффект нужно выбрать в списке Style 
(Стиль) один из следующих режимов и ввести соответствующие параметры:
•  Brightness (Яркость)
•  Tint (Цветовой тон)
•  Alpha (Прозрачность)
•  Advanced (Расширенный) одновременное изменения цветового тона и прозрачности

Blending (Режим наложения)
В программе Flash доступны следующие режимы наложения:
•  Normal – без наложения. Если внутри данного символа есть дугой символ, для которого ис-
пользован режим наложения, то будет виден �ффект внутреннего режима наложения.
•  Layer – слой    •  Darken – затемнение
•  Multiply - умножение   •  Lighten – осветление
•  Screen – �кран    •  Overlay - перекрытие
•  Hard light – направленный свет  •  Add - добавление
•  Subtract - вычитание   •  Difference - разница
•  Invert – инверсия (инвертируется нижележащий слой)
Alpha (прозрачность) и Erase (стирание) позволяют получить полупрозрачные маски:
•  Alpha - там, где клип-маска был прозрачным, изображение тоже станет прозрачным)
•  Erase - изображение станет прозрачным там, где был непрозрачным клип-маска

Создание полупрозрачных масок

1.  Поместить в ролик то изображение, для которого нужно создать маску
2.  Над изображением создать контур, который будет маской, сделать часть контура прозрачной 
и конвертировать данный контур в клип, установить для клипа режим наложения Alpha или 
Erase (клип-маска станет невидимым)
�.  Конвертировать изображение и клип-маску в единый новый клип и установить для него  
режим наложения Layer (слой)

Filters (Фильтры)
Чтобы добавить фильтр необходимо нажать кнопку Add filter, расположенную в нижней левой 
части секции Filters палитры Properties и ввести параметры фильтра.
Наборы фильтров можно сохранять с помощью кнопки Preset. Также можно копировать 
фильтры с одного �кземпляра на другой. Для �того нужно нажать кнопку Clipboard (�уфер  
обмена) и выбрать сначала команду либо Copy Selected (Копировать выделенные), либо Copy 
All (Копировать все фильтры). Затем выбрать другой �кземпляр, снова нажать кнопку Clip-
board и выбрать команду Paste (Вставить).
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Режимы редактирования эталона

Двойной щелчок по �кземпляру любого символа переводит программу Flash в режим редак-
тирования эталона данного символа. При �том Вы видите в качестве заглушенного фона дру-
гие объекты, расположенные в ролике, а �талон будет показан с учетом трансформации, при-
мененной к данному �кземпляру. Такой режим называется Edit in Place (редактирование на 
месте). Режим Edit (редактирование) откроет �талон в том виде, как он храниться в библиотеке 
и на пустом фоне. Выбрать нужный режим редактирования можно из контекстового меню.

Замена эталона для данного экземпляра

Если вы настроили индивидуальные свойства �кземпляра (трансформация, фильтры и т.д.) 
можно заменить эталон данного символа, так что все настроенные параметры останутся, но 
будут применены к другому �талону. Для �то нужно выбрать экземпляр символа и на палитре 
Properties нажать кнопку Swap (Заменить). При �том откроется окно для выбора нового эта-
лонного символа.

Особенности масштабирования клипов

Если применять непропорциональное масштабирование, то у некоторых фигур (например, 
прямоугольник со скругленными углами) возникает деформация контура в углах. Для клипов 
можно включить режим Enable guides for 9-slice scaling. Для �того необходимо отрыть окно 
редактирования свойств клипа и нажать кнопку Advanced (Расширенные). В данном режиме 
клип будет разделен на 9 частей. Масштабироваться будут только центральные части, а четыре 
угловых фрагмента будут защищены от масштабирования и деформации. Однако в этом режи-
ме нельзя поворачивать экземпляр клипа.

Доступны следующие фильтры:

• Drop shadow (тень)
• Blur (размытие)
• Glow (свечение)
• Bevel (объем)
• Gradient Glow 
(градиентное свечение)
• Gradient Bevel
(градиентный объем)
• Adjust color
(настройка увета)

Параметр Knockout делает сам 
объект невидимым, остается 
только результат применения 
фильтра.

Внешний вид секции Filters

Примененные
фильтры и

их параметры

Добавить
новый фильтр

Управление наборами
фильтров (Preset)

Копирование/вставка
фильтров (Clipboard)

Удалить фильтр

Сброс настроек фильтра к
значениям по умолчанию

Включить/отключить 
фильтр
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Практическая работа

Все файлы, необходимые для выполнения данной работы, находятся на раздаточном диске в 
папке «lesson_02\Practice_Work_2»

Задание 1. Создание объемных «звезд»

1.  Создайте новый Flash-ролик и установите для него размеры 800 х 600 px

2. Переименуйте слой в «back» и нарисуйте в нем прямоугольник (в режиме объектного  
рисования) с размерами, совпадающими с размерами ролика (800 х 600 px) и координатами  
х = 0 px, y = 0 px. Раскрасьте фон ролика.

�.  Нарисуйте S-образную фигуру внизу ролика (так же в режиме объектного рисования). Рас-S-образную фигуру внизу ролика (так же в режиме объектного рисования). Рас--образную фигуру внизу ролика (так же в режиме объектного рисования). Рас-
красьте нарисованную фигуру. Чтобы убрать лишние части фигуры (если они есть) сдубли-
руйте фоновый прямоугольник и примените к нему и S-образной фигуре режим пересечения  
Modify > Combine object > Intersect.

4.  Рисуем «золотую» звезду. Создайте новый слой, дайте ему имя «star» и нарисуйте в нем 
звезду (в режиме слияния контуров). Сделайте для звезды градиентную заливку, как показано в 
файле step_sample.swf - Шаг 1. 

5.  Выделите только заливку звезды (не трогая обводку) и преобразуйте ее в объект, используя 
команду Modify > Combine object > Union.

6.  Создаем блик. Нарисуйте S-образную форму (в режиме объектного рисования), сделай-S-образную форму (в режиме объектного рисования), сделай--образную форму (в режиме объектного рисования), сделай-
те для нее более светлую градиентную заливку. Сдублируйте звезду (заливку звезды, ко-
торая уже является объектом). Примените к ней и S-образной фигуре режим пересечения  
Modify > Combine object > Intersect. При необходимости откорректируйте градиентную залив-
ку блика, чтобы было похоже на Шаг 2 в файле step_sample.swf.

7.  Конвертируйте готовую звезду в клип (Movie Clip) с именем «star». Добавьте текст «First!» 
или любой другой. Выделите звезду и текст и снова конвертируйте в клип с именем «star_1». 
Таким образом, на главной временной шкале у нас будет находиться �кземпляр клипа «star_1», 
внутри которого будет находиться текст и �кземпляр клипа «star».

8.  В библиотеке (Library) два раза сдублируйте клип «star_1». Назовите копии «star_2» и 
«star_3». Внутри �тих символов замените текст на «Second!» и «Third!» соответственно. Также 
измените цвет звезд внутри �тих символов. Для �того в инспекторе свойств (панель Properties), 
раздел Color Effect, в списке Style выберите пункт Tint и установите необходимые значения.  

9.  На главной временной шкале примените к звездам (Movie Clip) фильтры 
(например, тень - Drop Shadow).

Пример выполненного задания: sample.swf



Продолжительность 180 минут

Тема занятия:

Занятие 3
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Базовые типы анимации в Adobe Flash CS4 

Классификация типов анимации

В редакторе Adobe Flash CS4 используются следующие типы анимации:

Работа с временной шкалой. Типы кадров

Процесс создания анимации в программе Flash заключается в том, что Вы создаете кадры 
на временной шкале ролика, помещаете в �ти кадры мультимедийные объекты и управля-
ем их свойствами. Анимацию также можно создать программным путем, с помощью языка  
ActionScript, но в данном курсе мы не рассматриваем такой способ.

Типы кадров

В программе Adobe Flash CS4 различают следующие типы кадров:
Keyframe•  (Ключевые кадры - обозначаются черным кружком)

Кадры, в которые пользователь может размещать объекты анимации (символы, или графичес-
кие объекты). К ним так же можно добавлять аудио-фрагменты и команды ActionScript.

Blank Keyframe•  (Пустые ключевые кадры - обозначаются белым  кружком с обводкой)
Кадры, в которых пока не размещен ни один объект анимации. 

Property Keyframe•  (Ключевые кадры свойств - обозначаются черным ромбом)
Кадры, в которые нельзя поместись новый объект анимации, но можно изменять свойства теку-
щего объекта анимации.

Frame•  (Промежуточные кадры)
Кадры, в которые пользователь самостоятельно не может вносить изменения. Их содержимое  
рассчитываются программой Flash автоматически. 
Различают анимационные промежуточные кадры (являются частью полуавтоматической  
анимации движения – Motion T�een) и статические промежуточные кадры (не являются час-
тью анимации движения Motion T�een). Промежуточные кадры нужно для того, чтобы про-Motion T�een). Промежуточные кадры нужно для того, чтобы про- T�een). Промежуточные кадры нужно для того, чтобы про-T�een). Промежуточные кадры нужно для того, чтобы про-). Промежуточные кадры нужно для того, чтобы про-
длить диапазон видимости предыдущего ключевого кадра.
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При создании нового ролика создается один слой и один пустой ключевой кадр (Blan� Key�rame). 
Любой слой обязательно начинается с ключевого кадра, либо заполненного, либо пустого. 
Если вы помещаете какой-либо объект в пустой ключевой кадр (B�an� �e��ra�e), он автомати-B�an� �e��ra�e), он автомати- �e��ra�e), он автомати-�e��ra�e), он автомати-), он автомати-
чески становиться «простым» ключевым кадром (�e��ra�e). Если удалить все содержимое из 
ключевого кадра (�e��ra�e) – он станет пустым ключевым кадром (B�an� �e��ra�e).

Внешний вид палитры Timeline (Временная шкала) с кадрами различных типов:

Управление кадрами

Добавление кадров:

Чтобы добавить новый кадр нужно воспользоваться одной из команд подменю Insert > Timeline 
(Вставка > Временная шкала) или выделить на временной шкале кадр, после которого нужно 
добавить новый кадр и воспользоваться командами контекстного меню:
• Insert Frame (Вставка промежуточного кадра) – F5
• Insert Keyframe (Вставка ключевого кадра) – F6
При этом в кадр автоматически копируется содержимое предыдущего ключевого кадра
• Insert Blank Keyframe (Вставка пустого ключевого кадра) – F7

Изменять порядок следования кадров, можно перетаскивая их с помощью мыши. Если при 
перетаскивании кадра держать нажатой клавишу ALT, будет создана копия данного кадра.

Чтобы удалить кадры, выделите нужный диапазон кадров и выполните команду контекстного 
меню Remove Frames (Удалить кадры). Чтобы удалить ключевой кадр необходимо выделить и 
удалить весь диапазон данного кадра. 

Можно преобразовать ключевой кадр в промежуточный, тогда кадры его диапазона види-
мости вольются в диапазон предыдущего ключевого кадра. Для �того нужно выделить ключе-
вой кадр и выполнить команду контекстного меню Clear Keyframe (Очистить ключевой кадр).

Нажатие клавиши Delete – удаляет только содержимое кадров, но не сами кадры.

Пустой ключевой кадр
(Blank Keyframe)

номер текущего кадра

частота смены кадров

время, прошедшее от начала ролика

Ключевые кадры
(Keyframe)

Маркер конца
диапазона видимости
ключевого кадра

Маркер положение 
текущего кадра
(Playhead)

Промежуточные
кадры (Frame)

Ключевой кадр свойств
(Property Keyframe)
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Классическая расчетная анимация движения
(Classic Tween)

При классической анимации движения Вы определяете свойства объекта анимации только в 
ключевых кадрах, а все промежуточные кадры просчитываются автоматически. 
Ключевые кадры свойств (Property �e��ra�e) в данном типе анимации не используются. 

В классической анимации движения могут участвовать только экземпляры символов.  
При чем на каждом слое анимации должен находиться только одни экземпляр.

Чтобы создать классическую анимацию движения необходимо:

1.  Выделить слой, в котором будет располагаться данная анимация. 
2.  Создать в нем ключевой кадр и поместить в него объект анимации. 
�.  Выделить данный ключевой кадр на временной шкале (Timeline) и выполнить команду кон-Timeline) и выполнить команду кон-) и выполнить команду кон-
текстного меню Create Classic Tween (Создать классическую анимацию движения). 
При этом если вы разместите в кадре не экземпляр символа, а просто контур или растровое 
изображение, или же разместите в одном кадре слоя несколько экземпляров, программа Flash  
автоматически создаст новый символ типа (Graphic – графический символ), в который будет 
помещено все содержимое кадра.
4.  Создать на временной шкале в том же слое еще один ключевой кадр и изменить в нем любой 
параметр �кземпляра (положение, трансформация и т.д.)
Анимация готова!

Покадровая анимация

Покадровая анимация наиболее близка к классической технологии создания мультфильмов. Со-
здается серия кадров, в каждом из которых прорисовывается объект на разных стадиях дви-
жения. Каждый кадр рисуется независимо от других и для дизайнера �то самый трудоемкий 
путь создания анимации. В данном случае программа Flash при воспроизведение ролика просто 
демонстрирует кадры один за другим с заданной частотой. 

Частота смены кадров едина для всего flash-ролика и задается в параметрах ролика  
(Modi�y > Document). Т.е. нельзя установить разную частоту воспроизведения для разных вре-Modi�y > Document). Т.е. нельзя установить разную частоту воспроизведения для разных вре- > Document). Т.е. нельзя установить разную частоту воспроизведения для разных вре-Document). Т.е. нельзя установить разную частоту воспроизведения для разных вре-). Т.е. нельзя установить разную частоту воспроизведения для разных вре-
менных шкал, находящихся внутри символов.

Чтобы движение выглядело более плавным, необходимо прорисовывать больше кадров.  
Но �то, во-первых, повышает трудоемкость создания ролика, а во-вторых, возрастает объем 
получаемого файла. По�тому данный тип анимации используется достаточно редко.
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Работу про рассчитыванию изменений во всех промежуточных кадрах выполняет программа 
Flash. Вы управляете только параметрами объекта в ключевых кадрах.

Существует другой алгоритм создания классической анимации движения:
1.  Создать слой для анимации, добавить ключевой кадр и поместить в него объект.
2.  Затем создать второй ключевой кадр и изменить в нем свойства объекта
�.  После �того выделить на временной шкале любой кадр между созданными ключевыми кад-
рами и выполнить контекстную команду Create Classic Tween.

Данный алгоритм подходит только в том случае, если в кадре содержится единственный �кзем-
пляр символа. Иначе будет создано 2 новых графических символа. И их �кземпляры будут 
помещены в первый и последний ключевые кадр анимации.

Классическая анимация движения на временной шкале отображается сплошной линией со 
стрелкой. Нарушенная анимация отображается пунктиром.

Параметры классической анимации движения

Чтобы получить доступ к параметрам анимации необходимо выделить на временной шкале 
первый кадр диапазона анимации. При �том на палитре Properties (Инспектор свойств) для 
данного типа анимации будут доступны следующие параметры:

Ease•  (Положительные значения дают ускорение движения, а отрицательные - замедление)
Rotate•  (Вращение) - можно настроить количество оборотов, совершаемых объектом:

 None – без вращения
 Auto – автоматическое
 CW – по часовой стрелке
 CCW – против часовой стрелки

Scale•  (Разрешить масштабирование). Если данный параметр не выбран (галочка снята),  
то при анимации объекта он не будет плавно масштабироваться
Sync•  (Синхронизация). Синхронизирует анимацию, находящуюся  внутри графического 
символа с главной временной шкалой.
Snap• , Orient to path нужны для анимации движения по пути и будут рассмотрены позднее.

Правее параметра Ease находится кнопка редактирования кривой ускорения (Edit easing). 

При нажатии на �ту кнопку появляется окно, 
в котором можно задавать пользовательские 
кривые ускорения. 

По умолчанию включен параметр Use one set- one set-one set- set-set-
ting for all properties (Использовать одну на-
стройку для всех параметров). Если отключить 
данный параметр – можно создавать различные 
кривые ускорения для разных свойств. 

Внизу данного окна находится кнопка Play, 
позволяющая просмотреть результат примене-
ния кривой ускорения.
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Просмотр и управление множеством кадров

Внизу палитры Timeline (Временная шкала) находятся кнопки, которые позволяют увидеть по-
ложение объекта сразу в нескольких кадрах:

Onion Skin•  – объект показывается с полупрозрачной заливкой
Onion Skin Outlines•  – объект показывается в виде контуров

Если слой заблокирован для него недоступно отображение нескольких кадров.

По умолчанию диапазон отображаемых кадров перемещается за указателем текущего кадра. 
Если в меню Modify Onion Markers выбрать параметр Anchor Onion, диапазон перестанет 
передвигаться вслед за указателем текущего кадра.

Команда Edit Multiple Frames позволяем редактировать все кадры выделенного диапазона  
(например, переместить всю созданную анимацию).

Анимация формы (Shape Tween)

Этот тип анимации также относиться к полуавтоматической (рассчетной) анимации.  
При анимации формы один контур преобразуется в другой. Такая анимация не применима к 
символам или растровым изображения. Объектом анимации должен быть обязательно век-
торный контур. Чтобы использовать символ или текст, его перед созданием анимации нужно 
разделить на контура с помощью команды Break Apart.

Для создания анимации формы нужно:

1.  Создать слой для анимации, добавить ключевой кадр и поместить в него некоторый контур
2.  Выделить кадр на временной шкале (Timeline) и выполнить контекстную команду Create 
Shape Tween (Создать анимацию формы).
�.  Создать второй ключевой кадр и либо изменить в нем существующий контур, либо помес-
тить в кадр новый контур. Возможно преобразование одного контура в несколько.

Выбрав первый кадр диапазона анимации можно настроить следующие параметры:
Ease•  (Ускорение/замедление)
Blend•  (Алгоритм преобразования):

Distributive – форма более гладкая, Angular – в большей степени сохраняются прямые линии.

Данный тип анимации дает не всегда предсказуемый результат. 
В некоторых случаях программа Flash вообще не сможет произвести анимацию.

На временной шкале появляются маркеры, кото-
рые указывают диапазон отображаемых кадров. 
Их можно передвигать с помощью мыши. 

Настроить количество отображаемых кадров также 
можно с помощью кнопки Modify Onion Markers 
(можно выбрать значения – 2, 5 или все кадры). 
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В сложных случаях нужно использовать управляющие хинты (�int), которые явно указываю 
программа Flash в какую точку конечного контура переходит точка исходного контура. 

Чтобы добавить управляющие хинты нужно:

1. Выделить первый кадр диапазона анимации формы. 
2. Добавить хинт с помощью команды Modify > Shape > Add Shape Hint (Модификация >  
Форма > Добавить хинт формы) и перетащить его на нужную точку исходного контура. 
�. Затем необходимо перейти на второй ключевой кадр анимации и поместить хинт на соответс-
твующую точку конечного контура. Правильно поставленный хинт становиться зеленым.

Хинты действуют только на один диапазон анимации (то есть два соседних ключевых кадра). 
Удалить выбранный хинт (Remove Hint) или все хинты (Remove All Hint) удобнее из контекс-
тного меню. Если хинты не отображаются, выделите ключевой кадр, где были хинты и выпол-
ните команду View > Show Shape Hints (Вид > Показать хинты).

Практическая работа

Все файлы, необходимые для выполнения данной работы, находятся на раздаточном диске в 
папке «lesson_03\Practice_Work_3» ( включая примеры выполненных заданий).

Задание 1. Покадровая анимация

1.  Откройте файл 01_start.fla. 

2.  В слое «singer» в первом кадре находятся 11 изображений с различными фазами движения 
героя. Их необходимо последовательно распределить по кадрам, так чтобы в каждом ключевом 
кадре слоя «singer» находилось только одно изображение.

�.  Затем используя опцию временной шкалы Edit Multiple Frames, выровняйте изображения 
во всех 11 кадрах по правой и нижней границе. 

4.  Чтобы создать цикличную анимацию нужно скопировать кадры с 5 по 10 (включительно), 
расположив их в обратном порядке. Таким образом, анимация будет повторятся  с 4 до 17 кад-
ра. Этот фрагмент анимации можно скопировать и вставить несколько раз, что певец дольше 
исполнял свою песню.

5.  В конец анимации копируем 1-й, 2-ой и �-й ключевые кадры, также располагая их в обратном 
порядке.

6.  Можно после первого ключевого кадра добавить несколько промежуточных, чтобы анима-
ция начиналась не мгновенно, а после некоторой паузы. Также можно добавить промежуточные 
кадры и в конце ролика.
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Задание 2. Классическая анимация (Classic Tween)

1.  Откройте файл 02_start.fla. 

2.  В слое «object» находится клип (Movie clip) с изображением мельницы. Двойным щелчком 
зайдите внутрь данного клипа.

�.  Внутри клипа в слое «anim», в котором нарисованы «крылья» ветряной мельницы, нужно 
создать классическую анимацию. Для �того необходимо выделить первый кадр и применить ко-
манду контекстного меню Create Classic Tween. Затем добавьте нужное количество ключевых 
кадров и создайте анимацию так, чтобы «крылья» мельницы вращались по часовой стрелке.

4.  Теперь создаем  анимированные облака. На главной временной шкале ролика (Scene1) до-
бавьте новый слой и поместите в него �кземпляр символа «clouds». Создайте классическую 
анимацию (Create Classic Tween). При �том в первом ключевом кадре облако должно находится 
за левой границей ролика, в последнем кадре анимации переместите облако за правую границу. 
Таким образом, получаем движущееся облако.

5.  Аналогично создайте еще несколько облаков – каждое в новом слое (в примере использовано 
три облака).

6.  Чтобы облака выглядели более реалистично, их анимации должны начинаться не синхронно 
и содержать разное количество промежуточных кадров (�то позволит облакам летать с разной 
скоростью). Анимация ветряных крыльев мельницы будет происходить независимо от главной 
временной шкалы, так как она находится внутри клипа (Movie Clip).

Задание 3. Анимация формы (Shape Tween)

1.  Откройте файл 03_start.fla. 

2.  В слое «objects» находится клип (Movie clip) с изображением машины. Анимацию формы мы 
будем создавать внутри данного клипа.

�.  Двойным щелчком зайдите внутрь клипа «car». Создайте для первого кадра анимацию фор-
мы (Create Shape Tween).

4.  Машина должна оставаться неизменной до 10-го кадра, по�тому его нужно сделать ключе-
вым кадром (F6), но ничего не менять.

5.  Затем в �0 кадре создайте пустой ключевой кадр (F7). В �том кадре нужно написать какой-
либо текст (например, mclaren.com). Установить желаемый стиль текста, после чего преобра-
зуйте текст в контура. Для �того необходимо дважды применить к текстовому полю команду  
Break Apart.

6.  Текст должен оставаться неизменным в течение 10-ти кадров. То есть нужно 40-й кадр сде-
лать ключевым (F6) и не вносить в него никаких изменений.

7.  Чтобы анимация выглядела «замкнутой» необходимо скопировать 1-й ключевой кадр и по-
местить его в 60-й кадр. В конце анимации можно добавить несколько (например,10) промежу-
точных кадров, чтобы получилась некоторая пауза между циклами повтора анимации.

8.  После �того вернитесь на главную временную шкалу ролика (Scene1) и примените к клипу 
«car» фильтры (например, тень - Drop shadow).



Продолжительность 180 минут
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Расширенные возможности анимации в  
Adobe Flash CS4

Движение по траектории на основе классической 
анимации движения (Classic Tween)

При создании классической анимации движения объект может перемещать из начальной точки 
в конечную только по прямой линии. Однако часто необходимо сделать так, чтобы объект дви-
гался по некоторому заданному маршруту, то есть нужно задать траекторию движения.

В редакторе Adobe Flash анимация движения по траектории является подвидом классической 
анимации движения (Classic T�een). Отличие состоит в том, что к слою, содержащему анимацию 
объекта, добавляется еще один служебный слой, в котором находится траектория движения.

Чтобы создать анимацию движения по траектории нужно:

1.  Создать слой для анимации, добавить ключевой кадр и поместить в него объект анимации 
(один �кземпляр какого-либо символа).
2.  Выделить ключевой кадр и создать классическую анимацию движения (контекстная команда 
Create Classic Tween)
�.  Правой кнопкой мыши щелкнуть по имени слоя анимации и выполнить контекстную коман-
ду Add Classic Motion Guide (Добавить направляющий слой классической анимации). 
4.  После �того непосредственна над слоем с объектом будет создан новый слой, в котором не-
обходимо нарисовать линию, которая будет задавать траекторию движения объекта. 
Важно, что контур, задающий траекторию движения, обязательно должен быть нарисован в 
режиме слияния. Не допускается использование в качестве траектории объекты рисования, 
примитивы, группы, символы или растровые изображения.
5. Далее необходимо установить объект в начало траектории. Создать в слое анимации второй 
ключевой кадр и продлить до �того кадра видимость слоя  траектории (F5). После �того во 
втором ключевом кадре передвигаем объект в конец траектории. Анимация готова!

Важно:

Объект привязывается к траектории • точкой регистрации (а не точкой трансформации).  
В общем случае точку регистрации нужно устанавливать в центр объекта.

Направляющий слой

Направляемые слои

Слой, свободный от направляющей движения
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Траектория • не отображается в конечном ролике, она видна только в среде разработки.

Траектория может • иметь пересечения. В некоторых случаях программа Flash обработает 
такую траекторию корректно, но в ряде ситуация анимация пойдет по кратчайшему пути.

Траектория • может быть замкнутой (можно даже оставить заливку контура, задающего тра-
екторию), но при �том могут возникнуть проблемы с определением начальной и конечной 
точки движения.

Можно добавлять на слой анимации объекта • дополнительные ключевые кадры, в кото-
рых можно изменять любые свойства �кземпляра, кроме его координат (например, транс-
формация или прозрачность).

Под одну направляющую движения можно помещать•  несколько слоев анимации. Чтобы 
связать слой с направляющей движения нужно просто перетащить его с помощью мыши 
под направляющий слой (чуть правее значка управляющего слоя). Освободить слой – пере-
тащить его чуть вниз и влево, при �том значок слоя снова примет нормальный вид.

Если с направляющим слоем не связан ни одни слой анимации, его значок пример такой • 
вид: . Слой станет простым служебным слоем (Guide), при тестировании ролика со-
держимое �того слоя не будет отображаться. Если связать такой слой с каким-либо слоем 
анимации, он снова автоматически станет направляющим слоем анимации.

Параметры анимации движения по траектории

Если выделить первый кадр диапазона анимации, то на палитре Properties (Инспектор свойств) 
будут доступны параметры:

Snap•  – привязать объект к траектории движения
Orient to path•  – ориентация по пути (то есть во время движения объект будет автоматически 
поворачиваться так, чтобы его ось � совпадала с касательной к траектории). При �том пара-
метр Rotation (Вращение) должен иметь значение Auto.

 
Полезные клавиши:

Если установлен параметр Snap, объект можно передвигать по траектории с помощью кла-
виш-стрелок на клавиатуре. Удерживание клавиши SHIFT перемещает сразу на 10 пикселов.

Перемещения на один кадр вперед по временной шкале – клавиша «>»
Перемещения на один кадр назад по временной шкале – клавиша «<»

Работа с масками

Маски предназначены для того, что сделать часть объекта невидимой без удаления �той части. 
В редакторе Flash маски реализованы как еще один тип управляющего слоя.

Чтобы добавить к объекты маску нужно:

1.  Создать два слоя. В нижний слой поместить маскируемый объект (тот, который нужно час-
тично скрыть), а в верхнем слое разместить маску. 
2.  Щелкнуть правой кнопкой мыши по имени слоя, содержащего будущую маску, и выполнить 
контекстную команду Mask (Маска). К объектам сразу же будет применена созданная маска.
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Важно:

Объект будет невидим так, где слой маски пуст.• 

Если слой-маска и все его маскируемые слои • заблокированы, то в среде разработки Вы 
видите результат применения маски. Если разблокировать хотя бы одни из �тих слоев – мас-
кируемый и маскирующий слои будут видны по отдельности и их можно редактировать.

Маской могут быть • ЛЮБЫЕ графические объекты, то есть контура, объекты рисования, 
примитивы, группы, символы и даже растровые изображения! Но в слое маски должен рас-
полагаться только ОДИН объект. Если в слой-маску будут помещены несколько объектов, 
то в качестве маски будет использован первый объект (объект, который поместили раньше 
других), а остальные объекты будут игнорироваться. Исключение составляют контура, на-
рисованные в режиме слияние – можно использовать в качестве маски несколько непере-
секающихся объектов. 

К слою-маске • можно применять анимации – Motion T�een (Анимация движения), Classic 
Motion T�een (Классическая анимация движения), Shape T�een (Анимация формы), но не-
льзя применять трехмерные трансформации.
К маскируемому слою можно применять • любые анимации, баз ограничений.

Если в качестве маски использован символ (типа Movie Clip), то внутри �того символа мож-Movie Clip), то внутри �того символа мож- Clip), то внутри �того символа мож-Clip), то внутри �того символа мож-), то внутри �того символа мож-• 
но помещать анимацию (например, анимацию движения по траектории)

Края маски всегда будут оставаться • жесткими (нельзя получить полупрозрачность).  
Полупрозрачную маску можно сделать с помощью режимов наложения (см. Занятие 2).

Под один маскирующий слой можно помещать • несколько маскируемых слоев. Переме-
щать слой под маску или из-под нее можно просто передвигая его мышью.

Если со слоем-маской не связан ни один маскируемый слой, то его значок пример вид: • .  

При тестировании ролика содержимое слоя-маски никогда не будет отображаться.• 

Обратный порядок анимации

Если на временной шкале выделить некоторый диапазон анимации (два или более ключевых 
кадров) и применить контекстную команду Reverse Frames (Обратный порядок кадров), то дан-
ный фрагмент анимации будет воспроизводиться в обратном порядке. При �том выделенные 
ключевые кадры просто соответствующим образом поменяются местами.

Слой-маска
(маскирующий слой)

Маскируемые слои
Исходные объекты Маска Результат

Свободный от маски слой
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Анимация движения (Motion Tween) на основе объектов

Данный тип анимации появился только в Adobe Flash CS4. Он как бы совмещает в себе клас-
сическую анимацию и анимацию движения по траектории, облегчая процесс манипулирования 
объектами.

При классической анимации можно управлять объектом только в ключевых кадрах. При �том 
надо сначала создать ключевой кадр, выделить объект и изменить его свойство. То есть класси-
ческая анимация – �то набор ключевых кадров, в каждом из которых находится объект анима-
ции и определен набор свойств �того объекта.

При анимации движения (Motion Tween) диапазон анимации (все кадры анимации) рассматри-
вается как единое целое. Такая анимация содержит только ОДИН ключевой кадр (Key�rame - 
 первый кадр анимации), в него помещается объект анимации. Чтобы изменять свойства объек-
та создается нужно количество ключевых кадров свойств (Property Key�rame). 

Преимуществом является то, что Вы во-первых можете управлять анимаций, как единым це-
лым, а во-вторых, можете легко выделить объект анимации в любом кадре (просто щелкнув 
по нему инструментов выделения Selection Tool) и изменить его свойства (например, передви-
нуть или повернуть). При �том в слое анимации автоматически будет создан ключевой кадр 
свойств (Property Key�rame). 

Чтобы создать анимацию движения необходимо:

1.  Создать слой, добавить ключевой кадр (Keyframe) и разместить в нем объект анимации. 
Объектом должен быть ОДИН экземпляр некоторого символа (любого типа) или ОДИН тек-
стовый объект. Если �то условие не выполнено, все содержимое ключевого кадра будет поме-
щено в новый символ. Но тип этого символ уже будет клип (Movie Clip).
2.  Выделить ключевой кадр на временной шкале и выполнить команду контекстного меню  
Create Motion Tween (Создать анимацию движения).
�.  При �том сразу будет создан диапазон анимации, длительностью 1 секунда (количество кад-
ров зависит от выбранной скорости смены кадров).
4. Далее в нужных кадрах выделяете объект и настраиваете его свойства, ключевые кадры 
свойств создаются автоматически.

Чтобы расширить или сузить диапазон анимации необходимо подвести курсор к его краю. Кур-
сор изменит вид на двунаправленную стрелку, с помощью которой можно изменять длинную 
диапазона анимации. При �том пропорционально сместятся все ключевые кадры свойств.

Редактируемая
траектория

Объект
анимации

Ключевой кадр (Keyframe),
в котором находится

объект анимации

Маркер изменения длины
диапазона анимации

Ключевые 
кадры свойств
(Property Keyframe)
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Работа с траекторией и перемещение анимации
Если во время анимации движения объект анимации перемещается по рабочей области, для 
него будет автоматически создана траектория движения. На ней будет отображаться столько 
узловых точек, сколько кадров занимает данная анимация.

Траекторию можно выделить как отдельный объект и трансформировать, ее также можно ис-
кривлять с помощью инструмента выделения Selection Tool и изменять управляющие точки 
инструментом Subselection Tool. То есть траекторию можно редактировать, как и любой век-
торный контур, но к ней нельзя применять инструменты рисования (например, Pen - перо).

Чтобы переместить всю анимацию движения – нужно с помощью инструмента выделения 
Selection Tool выделить и объект и траекторию движение, после чего можно изменить их поло-
жение на рабочей области ролика.

Управление кадрами свойств
Создать ключевой кадр свойств на временной шкале можно:

либо с помощью быстрой клавиши•  F6 (�то привычная уже клавиша меняет свое свойство, 
если выделен слой анимации движения)
либо с помощью контекстной команды временно шкалы • Insert Keyframe. Для анимации 
движения при �том раскрывается список доступных свойств.

Выделить единичный кадр из диапазона анимации – щелчок с нажатой клавишей CTRL.

Свойства объекта, которыми можно управлять с помощью ключевых кадров свойств:
Position•  (Положение на рабочей области ролика)
Scale•  (Масштаб)
Skew•  (Сдвиг)
Rotation•  (Поворот)
Color•  (Цвет)
Filter•  (Фильтры)

Очистка ключевых кадров свойств
Чтобы удалить некоторые свойства объекта из ключевого кадра свойств, данный кадр не-
обходимо выделить и выполнить контекстную команды Clear Keyframe (Очистить клю-
чевой кадр). При �том нужно отметить те свойства объекта, которые должны быть удалены.  
Если выбрать пункт All (Все свойства), то данный ключевой кадр свойств будет полностью 
удален с временной шкалы. Если ни одни кадр не выделен, команда Clear Keyframe удалит вы-
бранные свойства из всех кадров свойств выделенного диапазона анимации.

Замена объекта анимации
Если перетащить на диапазон анимации �кземпляр другого символа, будет выведено диалого-
вое окно «Do you wish to replace the existing target object?» (Желаете ли вы заменить ли сущес-
твующий объект Анимации?). Если нажать кнопку OK, то все значения анимируемых парамет-OK, то все значения анимируемых парамет-, то все значения анимируемых парамет-
ров останутся, но будет применены к новому объекты.

Толька этот тип анимации позволяет сохранять стили движения и использовать трехмерные 
преобразования. Однако к кадрам данного типа нельзя добавлять сценарии ActionScript.
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Параметры анимации движения:
На палитре Properties (Инспектор свойств) доступны следующие параметры:

Ease•  (Ускорение/замедление)
Rotation•  (Вращение вокруг собственно оси)
Orient to path•  (Ориентация по пути)
Sync graphic symbols • (Синхронизовать внутреннюю анимацию графических символов)

Данные параметры действуют сразу на весь диапазон анмимации.

Стили движения

Стили движения также являются новинкой Adobe Flash CS4. Стиль движения – �то сохраненная 
анимация движения, в которую включена траектория движения и последовательность ключе-
вых кадров свойств, в которых уже определенны параметры объекта. Вы можете использовать 
готовые стили или создавать свои собственные. Работа со стилями движения осуществляется с 
помощью палитры Motion Presets (Стили движения).

Чтобы применить к объекту готовый стиль движения нужно:
1. Создать слой и разместить в нем объект анимации.
2. На палитре Motion Presets (Стили движения) выбрать нужный стиль движения и нажать 
кнопку Apply (Применить), расположенную внизу данной палитры. 
При �том для объекта автоматически будет создана анимация движения (Motion Tween). Диапа-
зон анимации и параметры объекта будут установлены в соответствии с выбранным стилем.
Созданную анимацию можно редактировать, как обычную анимацию движения.

Чтобы создать свой стиль движения необходимо:
1.  Создать анимацию движения (Motion Tween), которая будет сохранена как стиль.
2.  Выделить нужный диапазон анимации и внизу палитры Motion Presets (Стили движения) 
нажать кнопку Save Selection as Preset (Сохранить выделенное как стиль).
�. После того как Вы введете имя, созданные стиль появиться в папке «Custom Presets». 
Пользовательские стили можно организовывать в папки и удалять.

Стили движения храниться в виде XML-файлов. Чтобы для созданного стиля отображалось 
Preview (Предварительный просмотр) нужно сделать swf-файл, который будет показывать ре-
зультат применения данного стиля и разместить его в следующую директорию:
<Диск Windows>:\Documents and Settings\<пользователь>\Local Settings\Application
Data\Adobe\Flash CS4\en\Configuration\Motion Presets\

Копирование и вставка движения

Анимацию движения и классическую анимацию движения можно копировать с одного объ-
екта на другой. Для �того на временной шкале нужно выбрать диапазон анимации и выпол-
нить контекстную команду Copy Motion (Копировать движение). Затем выделить тот кадр или 
диапазон анимации, куда необходимо вставить движение и выполнить контекстную команду 
Paste Motion (Вставить движение). 

Для классической анимации также доступна команда Paste Motion Special (Специальная 
вставка движения), которая позволяет редактировать список вставляемых параметров.
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Инструмент Spray Brush Tool (Аэрограф)

Новые инструменты Spray Brush Tool (А�рограф) и Deco Tool (Декорирование) появился 
только в Adobe Flash CS4. Каждый «штрих» �тих инструментов оставляет группу экземпля-
ров выбранного символа. Внутри распространяемого символа можно создавать анимацию.  
Но она будет воспроизводить одновременно для всех �кземпляров. 
Инструмент Spray Brush Tool предназначен для хаотического распределения символов по ра-
бочей области ролика.

Чтобы выбрать символ, который будет распределяться инструментом Spray Brush Tool (А�-
рограф) нужно на палитре Properties (Инспектор свойств) нажать кнопку Edit (Редактировать). 
При �том откроется окно, содержащее список всех символов данного ролика.

На палитре Properties доступны следующие опции данного инструмента:

Default Shape•  – Устанавливает форму по умолчанию (круг), цвет формы можно изменить
Scale width•  и Scale height – масштаб исходного символа
Rando� scaling•  – Случайное масштабирование 
Rotate Symbol•  – Разрешить поворот символов
Rando� Rotate•  – Случайный поворот

Параметры кисти (Brush):
Width•  и Height - размеры кисти.  
Чем больше размер кисти, тем реже располагаются клонируемые символы. 
Brush Angel•  – Наклон. Результат заметен только если включен параметр Rotate Symbol.

 
Инструмент Deco Tool (Декорирование)

Предназначен для упорядоченного распределения символов. 
Инструмент не работает, если в настройках Edit > Preferences на вкладке Genera� выбран тип 
отмены действий Object-Level Undo.
На палитре Properties (Инспектор свойств) можно выбрать режимы работы инструмента и на-
строить соответствующие параметры. В любом режиме для выбора распространяемого симво-
ла  служит кнопка Edit, по которой открывается список всех символов данного ролика.

Режим Symmetry Brush (Симметрия)
Параметр Test Collision, если он установлен, запрещает символам пересекаться. 
Доступно 4 способа копирования символов:

Reflect Across Line
Отражение через 
линию

Reflect Around Point
Отражение вокруг
точки

Rotate Around Point
Вращение вокруг
точки

Grid Translation
Распределение
по сетке
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Практическая работа

Все файлы, необходимые для выполнения данной работы, находятся на раздаточном диске в 
папке «lesson_04\Practice_Work_4» ( включая примеры выполненных заданий).

Задание 1. Классическая анимация. Движения по траектории. 
работа с инструментами «Spray Brush Tool» и «Deco Tool»

1.  Откройте файл 01_start.fla.

2.  В слой «ball» поместите мяч (перетащите из библиотеки �кземпляр символа «ball»), который 
будет двигаться по траектории и попадать в корзину.

�.  Создайте слой с классической направляющей движения. Для �того выделите слой «ball» и 

Режим Grid Fill (Заполнение по сетке)
В �том режиме выбранный символ копируется вдоль осей координат. Если щелкнуть инстру-
ментом внутри какого-либо объекта (контура или даже символа), то выбранным символом будет 
заполнен только �тот объект. Если щелкнуть вне объекта, то будет заполнено только пространс-
тво вне его. Если ни одного объекта нет – будет заполнена вся рабочая область ролика.

Можно настроить:

Default Shape•  – Устанавливает форму по умолчанию  
(квадрат), цвет формы можно изменить
�orizontal Spacing – Горизонтальные промежутки• 
Vertical Spacing – Вертикальные промежутки• 
Pattern Scale – Размер исходного символа• 

Настраиваемые параметры:
Branch angel•  – Угол ветви
Pattern Scale•  – Размер клонируемого узора
Segment length•  - Длина сегментов между  
узлами листьев и цветов.

Можно создавать «растущие» лиственные орнаменты. Для �того необходимо выбрать параметр 
Animate Pattern (Анимированный узор) и ввести значение Frame Step (чем меньше �то значе-
ние, тем больше кадров анимации будет создано). Анимация автоматически остановиться, как 
только будет покрыта вся доступная для узора площадь.

Если щелкнуть инструментом Deco Tool в режиме Vine Fill внутри какого-либо объекта  
(контура или символа), то орнаментом покроется только площадь данного объекта.

Режим Vine Fill (Растительный орнамент)
Можно выбрать символы для ветвей (Lea�) и цветов (Flo�er) орнамента или использовать фор-Flo�er) орнамента или использовать фор-) орнамента или использовать фор-
мы по умолчанию (Default Shape), для которых можно настроить нужный цвет.
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выберите команду контекстного меню Add Classic Motion Guide. Нарисуйте в данном слое 
траекторию движения мяча.

4.  Для слоя «ball» создайтк классическую анимацию (Create Classic Tween). Дабавьте нужное 
количество ключевых кадров, в каждом из них поместите мяч на соответствующий участок 
траектории.

5.  Настройте параметры анимации движения так, чтобы мяч во время движения вращался вок-
руг своей оси.

6.  Анимация готова, теперь нужно «украсить» фон. Для �того с помощью инструмента  
Spray Brush Tool (а�рограф)  мы «разбросаем» в произвольном порядке, подготовленные за-
ранее символы. Если внутри �тих символов должна быть анимация, то создаем клипы (Movie 
clip), если же �то будут статические объекты можно создавать графические символы (Graphic).

7.  Чтобы создать �лементы фона, сначала нарисуйте простые формы (примитивы) и сохраните 
их как графические символы (Graphic). Затем с помощью инструмента Deco Tool (Декорирова-
ние) в режиме Symmetry Brush (Симметрия) расположите примитивы в нужном порядке.  

Задание 2. Маски. Анимация движения

1. Откройте файл 02_start.fla. 

2.  В каталоге «line» находятся 5 слоев, в каждом из которых содержится свой фрагмент графи-
ка. Нужно к каждому слою данной папки добавить анимированную маску, чтобы создать иллю-
зию, что линия прорисовывается маркером. 

�.  Чтобы создать такую маску нужно выбрать слой с первым фрагментов графика «line_1», 
добавить над ним новый слой и установить режим слоя «маска» (выбрав команду контекстного 
меню Mask). 

4.  В слое маски нарисуйте небольшой прямоугольник, конвертируйте его в графический сим-
вол (Graphic) и создайте для него классическую анимацию (Create Classic Tween). В первом 
кадре анимации поверните прямоугольник так, чтобы он стал параллелен данному фрагменту 
графика, и установите его вне линии графика. В последнем кадре анимации с помощью инстру-
мента трансформации (Free Transform Tool) увеличьте прямоугольник или просто перенеси-
те (если он достаточно большой) так, чтобы он полностью закрыл данный фрагмент графика. 
Анимация маски должна завершиться к моменту появления следующего фрагмента графика  
(то есть анимация длится 10 кадров).

5.  Создайте аналогичные маски для всех других фрагментов графика. Для всех масок исполь-
зуйте один и тот же графический символ (прямоугольник), только изменяйте его размеры и угол 
поворота.

6.  Теперь добавляем маркер. Для �того в верхний слой перените из библиотеки �кземпляр сим-
вола «marker». 

7.  Создайте для маркера анимацию движения (Create Motion Tween). Сначала установите 
положение маркера в угловых точках графика (синие кружки). Чтобы движение выглядело бо-
лее реалистично, измените угол поворота маркера при прохождении различных фрагментов 
графика. Затем более точно откорректируйте положения и угол поворота маркера так, чтобы он 
не опережал и не отставал от «рисующейся» линии.
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Тема 1. Простейшая 3D анимация 

В редакторе Adobe Flash CS4 впервые появилась возможность манипулировать плоскими объ-
ектами в трехмерном пространстве. Flash реализует трехмерное пространство добавляю ось Z 
ко всем свойствам объекта. 

Важно, что трехмерные �ффекты применимы только к экземплярам клипов (Movie Clip) 
и в настройках публикации ролика на вкладке Flash должны быть установлены параметры  
Flash Player 10 и ActionScript 3.0. Доступ к настройкам публикации – File > Publish Setting 
(Файл > Настройки публикации). Еще одно ограничение – трехмерные �ффекты нельзя исполь-
зовать в маскирующий слоях. 

Инструменты 3D-трансформации

Во Flash реализованы следующие инструменты трехмерной трансформации:
3D Rotation Tool•  (Трехмерный поворот или преобразование объекта)
3D Translation Tool•  (Параллельный перенос объекта)

После применения любого из �тих инструментов �кземпляр клипа считается трехмерным эк-
земпляром и при выделении на него накладывается разноцветный указатель осей координат. 
Это можно отключить выполнив команду Edit > Preferences и сняв на вкладке Genera� галочку 
Show axes for 3D movie clip. 
При редактировании �талона трехмерных �кземпляров становиться недоступным режим  
Edit in Place (Редактирование на месте).

Оба инструмента трансформации позволяют работать с объектами в глобальном и локальном 
пространстве. Глобальное пространство – �то пространство рабочей области ролика.  
Локальное – �то собственное пространство клипа. Переключить одно пространство на другое 

можно с помощью кнопки , расположенной в нижней части палитры Tools (Инструменты).

�D-трансформацию можно применять сразу к нескольким объектам. Для �того нужно выде-
лить все необходимые �кземпляры клипов, удерживая нажатой клавишу SHIFT.

Если выделить какой-либо �кземпляр клипа или группу �кземпляров с помощью инструментов 
�D-трансформации, то будут отображены оси координат. 

Каждая ось отображается своим цветом: X – красный, Y – зеленый, Z – синий. 
�елым кружком отображается центр осей координат, его можно передвигать с помощью инс-
трументов �D-трансформации. Центр осей координат не совпадает с точкой трансформации 
экземпляра, хоть и отображается таким же символом.

Вложенные клипы повернуты в локальном пространстве
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Кроме инструментов �D-трансформации, положение объекта в трехмерном пространстве мож-D-трансформации, положение объекта в трехмерном пространстве мож--трансформации, положение объекта в трехмерном пространстве мож-
но настроить с помощью палитры Transformation (Трансформация). На �той палитре можно 
задать точные значения углов поворота по каждой из осей (3D Rotatoin) и положение центра 
координат (3D Center Point). 
А на палитре Properties (Инспектор свойств) в секции 3D Position and View отображаются  
точные значения координат по каждой из осей (�, Y, Z).

Параметры точки обзора (камеры)

В Flash для каждого ролика можно настроить только одну точку обзора или камеру. Параметры 
камеры настраиваются на палитре Properties в секции 3D Position and View:

Perspective angel • (Угол перспективы)
Угол перспективы отвечает за видимый размер трехмерных объектов и их положение относи-
тельно границ ролика. Увеличение угла перспективы приближает объекты к зрителю, уменьше-
ние – отдаляет их. По умолчанию задано значение 550. Значение может изменяться от 10 до 1800.  
При изменении размеров рабочей области ролика значение угла обзора меняется автомати-
чески. Данный режим можно выключить, выполнив команду Modify > Document и сняв галочку 
Adjust 3D Perspective angel to preserve current stage projection.

Vanishing point•  (Точка исчезновения)
Точка исчезновения управляет ориентацией оси Z в �D-пространстве. Перемещая данную точ-D-пространстве. Перемещая данную точ--пространстве. Перемещая данную точ-
ку можно изменить направление, в котором  двигается объект при параллельном переносе вдоль 
оси Z. По умолчанию точка исчезновения находится в центре рабочей области ролика. 

Глобальное пространство координат

Свободный поворот сразу по трем осям координат
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Чтобы вернуться к значениям по умолчанию необходимо нажать кнопку Reset (Сброс).

3D-анимация

Анимация объектов в трехмерном пространстве возможно только при использовании анима-
ции движения (Motion Tween). При �том процесс создания �D-анимации ничем не отличается 
от создания анимации данного типа, только увеличивается число параметров анимации.  
Созданная анимация может быть сохранена как стиль движения (Motion Preset).

Редактор движения (Motion Editor)

Для более удобного контроля параметров анимации движения в Adobe Flash CS4 ввели редак-
тор движения (Motion Editor), внешний вид которого представлен на рисунке:

Добавить параметр

Названия и значения
параметров

Удалить параметр

Ширина кадров графа

Выбор кривой ускорения Кривые
ускоренияВключение/отключение ускорения

Высота свернутых строк
Высота развернутой строки

Сброс всей группы параметров

Навигация по ключевым кадрам свойств
Добавление/удаление ключевого кадра свойств

Текущий кадр

Ключевые
кадры

свойств
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Редактор движения выполнен  в табличном виде. По вертикали располагаются названия 
свойств объекта анимации. А по горизонтали отображаются параметры данных свойств и по-
кадровые графики, показывающие изменения параметров во времени.
Свойства разделены на группы:

Basic motion•  (�азовое движение)
 �, Y, Z – координаты объекта
 Rotation �, Rotation Y, Rotation Z – углы поворота

Transformation•  (Трансформация)
 S�e� �, S�e� Y – сдвиг объекта
 Scale �, Scale Y – масштаб

Color Effect • (Цветовые �ффекты)
Filters•  (Фильтры)
Eases•  (Ускорение)

Щелчок по строке любого параметра делает �ту строку развернутой (увеличивается высота 
строки) и тогда лучше видна амплитуда изменения данного параметра. Внизу редактора движе-
ния находятся кнопки, позволяющие настроить наилучший масштаб отображения.

Чтобы изменить значение какого-либо свойство объекта, необходимо выделить нужный кадр 
(сделать его текущим), а затем:

Либо и изменить значение свойства в столбце • Value (Значение).  
Если кадр не был ключевым кадром свойств, то такой кадр будет создан автоматически. 
Либо на покадровом графике (• Graph) передвинуть маркер, показывающий текущее значе-
ние. Чтобы создать ключевой кадр свойств нужно сначала щелкнуть по линии графа, удер-
живая клавишу CTRL.

  

Перемещаться между ключевыми кадрами свойств можно с помощью кнопок навигации, рас-
положенных в столбце Keyframe (Ключевые кадры): Go to previous keyframe (Предыдущий) 
или Go to next keyframe (Следующий). Создать ключевой кадр свойств можно, выделив про-
межуточный кадр и нажав кнопку Add or Remove Keyframe. Если кадр был ключевым кадром, 
то при нажатии кнопки Add or Remove Keyframe он будет преобразован в промежуточный.

Чтобы управлять цветовыми �ффектами (Color Effect) и фильтрами (Filters) нужно сна-
чала нажать кнопку «плюс» и выбрать из списка нужное свойство. Список цветовых  
эффектов и фильтров не отличается от аналогичных параметров палитры Properties.  
После того, как свойство добавлено, управление им осуществляется аналогично базовым  
свойствам. Чтобы удалить свойство - его необходимо выбрать и нажать кнопку «минус».

Добавление кривых ускорения

Чтобы применить к параметрам какое-либо ускорение, необходимо сначала добавить �то ус-
корение в секции Eases (Ускорение). Для �того необходимо нажать кнопку «плюс» и выбрать 
одно из предопределенных ускорение или пользовательское (Custom). 

Каждая кривая ускорения отображается своим цветом. Для предопределенных ускорений не-
льзя редактировать форму кривой ускорения, но можно настраивать параметры в столбце 
Value (Значение). Для пользовательского ускорения можно свободно редактировать форму 
кривой ускорения. Добавление/удаление ключевых кадров – щелчок, удерживая нажатой кла-
вишу CTRL.
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После того, как Вы добавили в секцию Eases все необходимые кривые ускорения, �ти ускорения 
станут доступны в списках выбора ускорения (столбец Eases). Вы можете выбирать разные 
кривые ускорения отдельно для каждого свойства. Можно временно отключать ускорение 
изменения какого-либо свойства, сняв соответствующую галочку в столбце Eases. 

Если к свойству применено ускорение, изменять вручную значения в поле Value нельзя, а на 
покадровом графе на линию изменения данного свойства накладывается пунктирная линия 
соответствующего цвета, показывающая кривую ускорения.

Тема 2. Обратная кинематика

Обратная кинематика – метод анимации группы взаимосвязанных объектов, с использовани-
ем шарнирной системы костей. Это позволяет перемещать объекты сложным и естественным 
образом с минимальными затратами времени и сил. Используя данный метод можно, например, 
сделать анимацию персонажей – движение рук и ног, мимику.

Чтобы использовать обратную кинематику в настройках публикации ролика на вкладке Flash 
должен быть установлен параметр ActionScript 3.0. Доступ к настройкам публикации –  
File > Publish Setting (Файл > Настройки публикации)

В основе создания обратной кинематики лежат кости. При движении одной кости, все связан-
ные кости будут двигаться вслед за костью, начавшей движение. Это ускоряет создание слож-
ной анимации связанных объектов. 

Цепочка костей называется каркасом (или скелетом). Кости, входящие в каркас, соединяются 
между собой в родительской иерархии. Каркас может быть линейным или разветвленным: 

Важно, что после того как к объекту добавлены кости, он переноситься на новый слой (Ar-Ar-
mature) и становиться позой обратной кинематики. Каждый слой позы обратной кинематики 
может содержать только один каркас.

Добавить на �тот слой новые объекты уже нельзя. Нельзя также скопировать кадры вре-
менной шкалы данного слоя. По�тому, чтобы получить более гибкое управление объектом,  
рекомендуется создавать обратную кинематику внутри клипа (Movie clip). Так же желательно 
максимально проработать все составные части объекта ДО добавления костей.

Линейный каркас Разветвленный каркас
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Для добавления костей служит инструмент  
Bone Tool (Кости). 

Кости можно применять к экземплярам символов 
(всех типов) и к контурам, созданным в режимах 
слияния и рисования объектами. Применять кости 
к группам нельзя.

Первая кость каркаса считается корневой. 
Каждая кость имеет головную и хвостовую часть.

Добавление костей к символам

В �том случае объект, который должен двигаться по законам обратной кинематики, разбивается 
на составные части, каждая из которых создается как экземпляр некоторого символа. Каждая 
кость связывает два соседних �кземпляра. Перед добавлением костей расположите �кземпляры 
символов на рабочей области так, как они должны располагаться в составном объекте. Элемен-
ты могут располагаться на разный слоях.

Чтобы создать объект обратной кинематики на основе символов необходимо:
1.  Создать и расположить в нужном порядке �кземпляры символов
2.  С помощью инструмента Bone Tool (Кости) щелкнуть по �кземпляру, который должен яв-
ляться корневым или головным �лементом каркаса. Не отпуская левую кнопку мыши, перевес-
ти инструмент Bone Tool на следующий �лемент каркаса. При �том появиться первая кость.
�.  Чтобы добавить �лемент к каркасу – нужно щелкнуть инструментом Bone Tool по хвостовой 
части кости и не отпуская кнопку мыши переместить инструмент на следующий �кземпляр.
4.  Повторять шаг � до тех пор, пока не будут связаны все �лементы каркаса. Если необходимо 
создать разветвленный каркас – сначала создайте главную ветвь каркаса. Затем выделите �к-
земпляр главной ветви с помощью инструмента Bone Tool и, не отпуская левую кнопку мыши, 
перетащите инструмент на первый �лемент дополнительной ветви. Затем последовательно со-
едините между собой все �лементы дополнительной ветви.

Добавление костей к контурам 

Нарисуйте 1. один или несколько контуров в режиме слияния или рисования объектами.
Обязательно 2. выделите всю фигуру (то есть все контура, образующие данную фигуру) инс-
трументом выделение (Selection Tool)
Щелкните инструментом �. Bone Tool по тому месту контура, где должна начинаться первая 
(корневая) кость, и не отпуская левую кнопку мыши переместите инструмент в другое место 
внутри контура. При �том появиться первая кость каркаса.
Чтобы добавить еще одну кость – нужно щелкнуть инструментом 4. Bone Tool по хвостовой 
части кости и, не отпуская левую кнопку мыши, переместить инструмент на новое место в 
контуре.

После того, как кости добавлены перемещать элементы каркаса по рабочей  
области можно с помощью инструмента выделения (Selection Tool). 

Корневая кость

Головная
часть кости

Хвостовая
часть кости
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Редактирование каркаса

Отдельные кости каркаса можно выделять с помощью инструмента выделения (Selection Tool). 
Чтобы выделить несколько костей – удерживаем нажатой клавишу SHIFT. Двойной щелчок 
по любой кости выделит все кости каркаса.

Чтобы удалить кость – ее нужно выделить и нажать клавишу DELETE. При �том будут удале-
ны все кости-потомки.

Если кости добавлялись к контуру, то изменять объект обратной кинематики можно только вы-
деляя и перемещая его кости. Если же кости добавлялись к экземплярам символов, то можно 
перемещать как кости, так и сами �лементы каркаса.

Любой экземпляр, входящий в каркас, можно выделить инструментом Selection Tool и настро-
ить любые параметры �кземпляра  (трансформация, цветовые �ффекты, фильтры).

Чтобы изменить положение �кземпляра относительно других �лементов каркаса, его нужно 
выделить, удерживая нажатой клавишу ALT, и переместить на новое место.

Каждый �кземпляр может иметь только одну точку соединения (место, где сходятся кости). 
Положение �той точки определяется положением точки трансформации и его можно изменить 
с помощью инструмента Free Transform Tool (Свободная трансформация)

Ограничение движения кости

Чтобы движения каркаса выглядели более реалистично можно управлять свободой движе-
ния отдельных костей. Для �того необходимо выделить нужную кость и на палитре Properties  
(Инспектор свойств) установить соответствующие ограничения:

Чтобы переместить кость и всех ее потомков, не за-
трагивая родительскую кость, перемещайте кость, 
удерживая нажатой клавишу Shift.

Перемещать по костям каркаса можно также с помо-
щью кнопок навигации расположенных на палитре 
Properties (Инспектор свойств), которые показаны 
на рисунке справа:

Joint: Rotation•  (Вращение соединения)
 Enable - Разрешение вращения
 Constrain (Min, Max) – Ограничения диапазона

Joint: X и Y Translation•  (Перенос вдоль осей �, Y)
 Enable - Разрешение переноса
 Constrain (Min, Max) – Ограничения диапазона

Важно, что ограничения действуют на головную часть кости. Это значит, что ограничить сво-
боду вращения последнего элемента нельзя! Он может свободно вращаться вокруг кости. 
Чтобы избежать �того, нужно в качестве последнего (крайнего) �лемента каркаса добавить  
пустой клип. Однако �то нужно делать ДО добавления костей в каркас (после преобразования 
элементов в слой поз обратной кинематики новые элементы добавлять нельзя).

Child (Ветвь-потомк)

Parent (Родительская ветвь)

Next sibling
(Следующая
подветвь)

Previous sibling
(Предыдущая 

подветвь)

Вращение

Движение ограничено

Перенос по Y
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Анимация каркаса 

Как только вы добавили к каркасу кости, все �лементы каркаса автоматически переносятся на 
новый слой поз (Armature). В одном слое может находиться только один каркас. 
Диапазон анимации рассматривается программой Flash, как единое целое. Чтобы увеличить 
и уменьшить диапазон анимации, необходимо подвесит курсор к краям текущего диапазона, и 
изменить его длину.

Для создания анимации каркаса необходимо добавить в слой Armature нужно количество  
кадров поз (отображаются ромбиками) и изменить в них объект обратной кинематики. Все из-
менения промежуточных кадров Flash рассчитывает автоматически.

Работа с кадрами слоя поз (Armature)
Выделить отдельный кадр поз можно щелкнув по нему, удерживая нажатой клавишу CRTL. 
Управление кадрами поз осуществляется с помощью контекстных команд временной шкалы:

Добавить новый кадр • Insert Pose («горячая» клавиша F6)
Удалить выделенный кадр позы - • Clear Pose. 
Скопировать выделенный - • Copy Pose, вырезать - Cut Pose, вставить Paste Pose.
Если выделены • все кадры анимации каркаса, то данную анимацию можно преобразовать  
в покадровую с помощью команды Convert to Frame by Frame Animation.

Параметры анимации. Анимация при выполнении

На палитре Properties (Инспектор свойств) доступны следующие параметры:
Секция • Ease (Ускорение)

 Strength – интенсивность (Значение «0» – отсутствие ускорения),  Type – тип ускорения 
Секция • Options (Опции)

Type (тип анимации):
 Auhtortime (анимация в среде разработки)
 Runtime (анимация во время выполнения)
В �тот случае пользователь при просмотре ролика сможет сам передвигать части каркаса.
Этот параметр можно выбрать, если слой содержит только один кадр поз. 
Style (стиль отображения костей):
 Wire (Контур), Solid (Сплошная заливка), Line (Линия)

Коррекция взаимосвязей

Иногда при анимации объекта, когда кости добавляются не к �кземплярам символов, а к конту-
рам, преобразование контура идет не так как надо и контур деформируется. Чтобы избежать 
�того, можно откорректировать взаимосвязи костей и точек анимируемого контура. Для �того 
нужно выделить контур с помощью инструмента Bind Tool (Связывание). При �том отобра-
зятся кости каркаса и все опорные точки контура. 

Wire (Контур) Solid (Сплошная заливка) Line (Линия)



Цент компьютерного обучения при МГТУ им. Н.Э. Баумана Adobe Flash CS4. Уровень 1

62 Практическая работа

Практическая работа

Все файлы, необходимые для выполнения данной работы, находятся на раздаточном диске в 
папке «lesson_05\Practice_Work_5» ( включая примеры выполненных заданий).

Задание 1. 3D-Анимация

1.  Откройте файл 01_start.fla. 

2.  Данная композиция уже разделена на слои так, что в каждом слое находится один клип  
(Movie Clip). Необходимо для каждого слоя создать анимацию движения (Create Motion Tween). 
Анимация разных слоев должна начинаться в разное время, чтобы создалось впечатление  
«собирающейся» композиции.

�.  Используя инструменты 3D Rotation Tool и 3D Translation Tool, создайте иллюзию движе-
ния плоских �лементов композиции в трехмерном пространстве. 

4.  Добавьте нужное количество кадров свойств и в них при необходимости откорректируйте 
движение с помощью редактора движения (Motion Editor).

Задание 2. Обратная кинематика

1.  Откройте файл 02_start.fla. 

2.  С помощью инструмента Bone Tool (Кости) создайте скелет (каркас) человека. Старто-
вую точку установите в верхней части туловища. От нее расходятся четыре ветви скелета: к 
шее, обеим рукам и вниз через туловище к тазу. От шеи проведите кость к голове. От таза – 
к обеим ногам. Соедините костями все клипы, образующие руки и ноги. Каркас готов. 
Пример готового каркаса находится в файле 02_bone_ready.fla.

�.  Для суставов установите ограничения на углы вращения, настроив на палитре Properties 
параметры JOINT: Rotation.

4.  В слое поз (Armature) создайте анимацию движения человека. Для �того добавьте нужное 
количество ключевых кадров (кадров поз) и с помощью инструмента Selection Tool (Выделе-
ние) переместите части каркаса так, чтобы человек принял желаемую позу.

Если выделить какую-либо кость, то желтым цветом будут 
выделены все связанные с ней точки контура. 
Если выделить точку контура, то желтой линией будут  
выделены все связанные с ней кости. 

Чтобы добавить точку или кость – щелкаем по ней  
с нажатой клавишей SHIFT, чтобы удалить – удерживаем  
клавишу CTRL.

Опорные точки контура, подсоединенные только  
к одной кости отображаются в виде квадратиков, 
к нескольким костям – в виде треугольников.
 



Продолжительность 180 минут

Тема занятия:

Занятие 6

Первое знакомство с ActionScript
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Первое знакомство с ActionScript 

ActionScript – �то язык программирования, используемый в среде Adobe Flash. Он позволяет 
создавать интерактивные ролики, т.е. ролики, меняющие свое поведение в зависимости от 
действий пользователя.

Язык ActionScript относится к типу скриптовых языков программирования и основан на спе-
цификации ECMA-262. Его синтаксис схож с языком JavaScript и если у Вас бы опыт програм-
мирования на JavaScript, �то поможет в освоении языка ActionScript.

Язык ActionScript имеет обширную библиотеку встроенных классов, которые позволяют 
быстро решать большинство типовых задач.

Для написания сценариев (программных кодов) не обязательно знать все элементы языка  
ActionScript. Можно начинать изучение с самых простых конструкций, постепенно увеличивая 
сложность решаемых задач.

Версия языка ActionScript
ActionScript 1.0•  – исторические первая и самая простая версия языка ActionScript. В на-ActionScript. В на-. В на-
стоящее время она используется лишь в некоторых версиях проигрывателя Flash Lite для 
мобильных телефонов и устройств.
ActionScript 2.0•  – его иногда называют «языком программирования для дизайнеров». Для  
изучения его основ и практического применения  не требуется глубоких знаний программи-
рования. ActionScript 2.0 используется в основном проектах ориентированных на оформ-
ление.
ActionScript 3.0•  – новая версия языка, основанная на объектно-ориентированном программи-
ровании. Код, скомпилированный под данную версию, выполняется максимально быстро. 
Однако для изучения ActionScript �.0 требуются более глубокие знания объектно-ориенти-
рованного программирования. 

Скрипты, написанные на ActionScript �.0 НЕ совместимы с более ранними версиями языка и 
не могут смешиваться с ними! По�тому, важно определиться с версией  используемого языка 
ActionScript  до начала работы над проектом.

Где могут располагать сценарии ActionScript

Сценарии могут располагаться либо внутри flash-ролика, либо во внешнем файле. В данном 
курсе мы будет работать только со сценариями, находящимися внутри ролика.

Внутри flash-ролика, коды языка  ActionScript 2.0, могут располагаться на кадрах вре-
менной шкалы или  экземплярам клипов и кнопок. В языке ActionScript 3.0 скрипты распо-
лагаются только на кадрах, что помогает избежать децентрализации кода, когда весь код  
проекта разбит на маленькие кусочки, относящиеся к разным �кземплярам символов. 

Важно, что добавлять скрипты можно только к ключевым кадрам (Keyframe), которые не  
являются частью анимации движения (Motion T�een) или обратной кинематики (Armature).

В рабочей области ролика �кземпляры, имеющие коды ActionScript, никак не выделяются. На 
временной шкале кадры, имеющие скрипты, отмечаются  буквой a (action):       .
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Порядок выполнения сценариев

Первым выполняется код, расположенный в верхнем слое первого кадра ролика. Далее выпол-
няются все сценарии, относящиеся к кадрам или объектам нижележащих слоев первого кадра 
(по порядку следования слоев - сверху вниз). Только после �того Flash Player переходит к следу-Flash Player переходит к следу- Player переходит к следу-Player переходит к следу- переходит к следу-
ющему кадру ролика и так далее, пока не будет достигнут конец ролика.

Палитра Actions (Действия)

Для работы со сценариями ActionScript во Flash предназначена палитра Actions  (Действия). 
Данная палитра разделена на � части:

�лок «• Сценарий». Предназначен для ввода и редактирования  кода ActionScript
�лок «• Суфлер кода». Содержит иерархический перечень всех зарезервированных конструк-
ций языка. Двойной щелчок по любой конструкции добавляет в выделенное место блока 
«Сценарий»
�лок «• Навигатор сценариев». Указывает текущий �лемент (Current selection), то есть тот 
�лемент, чей сценарий в данный момент редактируется в блоке «Сценарий». А также содер-
жит полный список всех �лементов ролика, к которым добавлены сценарии ActionScript.  
Двойной щелчок по любому �лементы вызывает его сценарий на редактирование.

Внешний вид данной палитры представлен на рисунке:
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Блок «Сценарий»

Текущий элемент ролика
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(Show /  Hide Toolbox)
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Работа с комментариями
Add a new item to tha script
(Вызов Суфлера кода)

Свернуть / развернуть блок кода

Debug options (Опции отладки)Find (Поиск / Замена)

Insetr a target path (Вставка пути к объекту)

Check syntax  (Проверка синтаксиса)

Show code hint (Показывать подсказки кода)

Auto format (Автоформатирование кода)
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Управление сценариями ActionScript

Важно:
Язык ActionScript является • регистрочувствительным, то есть нельзя путать строчные (a) 
и прописные (A) символы.
Команды разделяются точкой с запятой «• ;»
�локи кода и тело функций помещаются внутрь фигурных скобок • {…}.

Для удобства чтения кода применяют форматирование, при котором каждый подчиненный  
�лемент помещается с отступом вправо. 
Также программа Flash автоматически включает цветовую подсветку кода:

Синий•  цвет – все зарезервированные конструкции языка
Черный•  цвет – все пользовательские конструкции
Зеленый•  цвет – текстовые строки, заключенные в кавычки, например: “текст”
Серый•  цвет – комментарии

Комментарии – �то не исполняемые строки кода, которые служат для пояснения какого-либо 
фрагмента кода. Так же можно закомментировать блок кода, чтобы временно исключить его из 
выполнения (как правило, во время отладки ролика).
// - обозначают однострочный комментарий (line comment)
/* - начало многострочного блока комментариев (bloc� comment)
*/ - конец многострочного блока комментариев (bloc� comment)

Настроить форматирование и подсветку кода можно с помощью команды Edit > Preferences 
(Редактирование > Настройки) вкладки ActionScript и Auto Format. 

Настройки отображения кода доступны из меню дополнительных опций палитры Action:
Ward Warp•  – перенос по словам
Line Numbers•  – номера строк
Hidden Characters•  – скрытые символы
Esc Shortcut keys•  – «быстрые клавиши» Escape-ввода

Во Flash для ускорения ввода зарезервированных конструкций языка используется  
Escape-ввод. То есть перед вводом имени команды необходимо нажать клавишу Escape и тогда 
не нужно вводить имя полностью, достаточно ввести «быстрые клавиши» данной команды.

Режим Script Assist (помощник кода) позволяет создавать скрипты с помощью мастера. При �том 
Вы не вводите скрипт полностью, а составляете его из �лементов, управляемых мастером.

Для вызовы контекстной справки необходимо выделить нужную функцию и нажать F1.

Управление временной шкалой ролика

Управление временной шкалой ролика осуществляется в помощью встроенных функций  
языка ActionScript. Это самая простая и наглядная группа функций. По умолчанию, воспро-
изведение анимации ролика начинается сразу и идет от первого кадра к последнему. Функции  
управления временной шкалой предназначены для остановки/воспроизведения анимации, а 
также для изменения последовательности отображения кадров ролика.

Мы будет рассматривать данную группу функций на примере языка ActionScript 2.0. 
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На палитре Actions (Действия) в блоке «Суфлер кода» функции управления временной находят-
ся группе Global Functions > Timeline Control (Глобальные функции > Управление временной 
шкалой). К данной группе относятся следующие функции:

stop();•    -  остановить анимацию
play();•    -  продолжить воспроизведение анимации
nextFrame();•   -  перейти к следующему кадру временной шкалы
prevFrame()• ;  -  перейти к предыдущему кадру временной шкалы
nextScene();•   -  перейти к следующей сцене ролика 
prevScene(); •  -  перейти к следующей сцене ролика 
stopAllSounds();•  -  остановить все звуки ролика

Вышеперечисленные функции не требуют аргументов.

gotoAndPlay();•  -  перейти к кадру и начать воспроизведение анимации
gotoAndStop();•  -  перейти к кадру и остановить воспроизведение анимации

Для последних функций требуется аргумент, указывающий номер того кадра, куда будет  
осуществлен переход. Аргументы функций указываются внутри круглых скобок.

В качестве аргумента можно либо прямо указать номер нужного кадра:
 gotoAndPlay(5); - перейти на 5 кадр,
либо использовать метку кадра.

Метки кадров

Любому ключевому кадрам (Keyframe), который не  являются частью анимации движения 
(Motion T�een) или обратной кинематики (Armature) можно назначить метку.

Метки облегчают переход к нужному  кадру. То есть, если в сценарии использованы ссылки на 
какой-либо кадр по номеру,  то при изменении анимации так, что содержимое кадра перемес-
тилось на временной шкале, Вам придется вручную изменять номер кадра во всех ссылках. 
При использовании меток такой проблемы нет, так как при перемещении кадра по временной 
шкале метка автоматически перемещается вместе с кадром.

Чтобы назначить кадру метку необходимо выделить нужный ключевой кадр и на палитре  
Properties (Инспектор свойств) в секции Lebel в поле Name ввести имя метки. При �том в поле 
Type (Тип) должно быть выбрано значение Name (Метка кадра).

На временной шкале кадры, имеющие метки обозначаются красным треугольником, рядом с 
которым указывается имя метки:

Важно, что когда метки кадров указываются в качестве аргументов функций, писать их нужно 
в двойных кавычках. То есть перейти на 5-й кадр и начать воспроизведение анимации можно  
с помощью следующей функции:

 gotoAndPlay("start frame");

На данном рисунке кадру 5 присвоена
метка: start frame
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Создание кнопок

Кнопки позволяют сделать flash-ролик интерактивным. Как и любой символ, кнопку можно 
создать либо с помощью команды New symbol, расположенной внизу палитры Library (�ибли-
отека), либо конвертировав какой-либо объект в символ («горячая» клавиша F8). Тип символа 
надо установить Button (Кнопка).

Кнопки – �то специализированные клипы, временная шкала которых содержит четыре кадра, 
каждый из которых соответствует одному состоянию кнопки:

Up•  – нормальное состояние кнопки (курсор мыши вне кнопки)
Over•  – состояние наведения (курсор мыши навели на кнопку)
Down•  – состояние нажатия (левую кнопку мыши нажали на территории кнопки)
Hit•  – зона чувствительности кнопки.

Чтобы кнопка меняла внешний вид, когда на нее наводят или «нажимают» мышкой, необходимо 
в каждом кадре  нарисовать соответствующие состояния кнопки:

Обработчики событий мыши

Чтобы некоторое действие было выполнено, как только произойдет определенное событие,  
необходимо использовать обработчик события. Для разных событий применяются соответству-
ющие обработчики. 

В ActionScript 2.0 для кнопок используется обработчик «on», если код добавляется к экземп-
ляру кнопки или соответствующая «событийная функция», если код добавляется к кадру вре-
менной шкалы.

Обрабатываются следующие события мыши:

press•  – нажали левую кнопку мыши в зоне чувствительности кнопки
release•  - нажали и отпустили левую кнопку мыши в зоне чувствительности кнопки  
(происходит в момент отпускания)
releaseOutside•  – нажали левую кнопку мыши на кнопке, а отпустили вне кнопки 
(происходит в момент отпускания)
rollOver•  – навели указатель мыши на кнопку
rollOut•  – вывели указатель мыши из зоны чувствительности кнопки

Состояние Hit специфично для программы Flash. Все, что нарисовано в �том состоянии не отоб-Flash. Все, что нарисовано в �том состоянии не отоб-. Все, что нарисовано в �том состоянии не отоб-
ражается в ролике, но определяет область чувствительности кнопки. 
Содержимое состояния �it может не совпадать по форме или вооб-�it может не совпадать по форме или вооб- может не совпадать по форме или вооб-
ще не пересекаться с видимой частью кнопки. Это состояние может 
помощь, если кнопка имеет сложную форму.

При просмотре flash-ролика указатель «мыши» 
при наведении на кнопку  будет автоматически 
изменять вид со «стрелки» на «руку», а кнопка 
перейдет в соответствующее состояние.

Up Hit
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dragOver•  - нажали левую кнопку мыши в зоне чувствительности кнопки, не отпуская 
кнопку мыши, вывели мышь за пределы кнопки, а затем вернули обратно на кнопку.
dragOut•  - нажали левую кнопку мыши в зоне чувствительности кнопки, не отпуская кноп-
ку мыши, вывели мышь за пределы кнопки

Добавление обработчика события к экземпляру кнопки

Чтобы добавить обработчик события к кнопке, необходимо на рабочей области выделить 
экземпляр нужной кнопки, открыть палитру Actions («горячая» клавиша F9) и в блоке  
«Сценарий» ввести необходимый код: 

Добавление обработчика события к кадру 

Чтобы добавить обработчик события мыши к кадру необходимо:
1. Выделить на рабочей области �кземпляр нужной кнопки и на палитре Properties (Инспектор 
свойств) присвоить ему Instance Name (Имя �кземпляра). Это позволит управлять данным �к-
земпляром с помощью языка ActionScript. Например, присвоим кнопке, которая будет останав-ActionScript. Например, присвоим кнопке, которая будет останав-. Например, присвоим кнопке, которая будет останав-
ливать анимацию, Instance Name: b_stop.
2. Для размещения кода ActionScript обычно создают отдельный слой, который располагают 
выше всех других слоев и называют «action». В �тот слой не размещают графические объекты, 
он содержит только сценарии, что упрощает доступ к кодам и облегчает работу над проектом. 
После создания слоя «action» нужно выделить его первый кадр и вызвать палитру Actions.
�. В блоке «Сценарий» вводим необходимый код. Важно, что при использовании «событийных 
функций» формат указания событий меняется на следующий:

Обработчик событий «on» в качестве аргумента 
требует указать то, событие мыши, по которому 
должно происходить действие (указывается в 
круглых скобках). 

Действия указываются внутри фигурных скобок 
и разделяются точкой с запятой.

Приведенный сценарий при нажатии на кнопку 
останавливает анимацию.

onPress, onRelease, • 
onReleaseOutside, • 
onRollOver, onRollOut, • 
onDragOver, onDragOut• 

Instance Name и событийная функция разделя- Name и событийная функция разделя-Name и событийная функция разделя- и событийная функция разделя-
ются оператором точка (dot).

Действия указываются внутри тела событийной 
функции (внутри фигурных скобок) и разделя-
ются точкой с запятой.

Обработчик
события

Событие
мыши

Действие
Экземпляр, к которому добавлен код

Instance Name
(Имя экземпляра) Событийная функция

Действие
Имя слоя и номер кадра, к которому добавлен код

Событие
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Создание баннеров. Функция getURL()

Создание flash-баннеров является весьма распространенной задачей. Как правило, баннер – �то 
обычный flash-ролик, вся площадь которого является ссылкой на некоторый Интернет-ресурс.

Чтобы создать баннер необходимо:

1. Создать анимированный ролик
Все баннеры должны иметь строго определенный размер и желательно как можно меньше 
весить. При создании анимации для баннера не стоит включать множество фильтров, потому 
что такие ролики при выполнении могут сильно загружать процессор компьютера.

2. Создать прозрачную кнопку
Выше всех слоев нужно создать новый слой и дать ему имя, например, «button». Продлить  
видимость �того слоя на все кадры анимации баннера. 
В �том рисуем прямоугольник, задаем ему размеры, равные размерам рабочей области  
баннера, и устанавливаем координаты x = 0, y = 0. 
Далее конвертируем прямоугольник в кнопку. Перемещаем ключевой кадр из состояния Up в 
состояние Hit. Теперь три первых (видимых) кадра пусты, а кадр �it, отвечающий за зону чувс-�it, отвечающий за зону чувс-, отвечающий за зону чувс-
твительности кнопки, содержит нарисованный прямоугольник. Это и есть прозрачная (невиди-
мая) кнопка. В среде разработки Flash такие кнопки отображаются голубым цветом.

2. Функция getURL()
Нужно дать кнопке имя �кземпляра Instance Name, например, b_Link. Выделить первый кадр 
слоя «button» (создавать новый слой скриптов в �том случае нет смысла), открыть палитру Ac-
tions и ввести следующий код:
 b_Link.onRelease = function(){
  getURL("http://ya.ru", "_blank");
 }
В качестве события обычно используют onRelease. 
Функция getURL принимает два параметра (оба текстовые строки – пишутся в кавычках):

URL нужно ресурса (• http://ya.ru)
Тип окна, в котором должна открыться ссылка:• 

 _blank  –  в новом окне _parent –  в родительском фрейме 
 _self  –  в том же окне _top   –  во фрейме главного уровня 
 
Внимание, из-за ограничений политики безопасности F�ash P�a�er, гипер-ссылки не будут ра-
ботать при запуске ролика с локальной машины.  

Если по одну событию должно происходить 
несколько действий, то все их нужно помещать 
внутрь одного обработчика. 

К одной кнопке можно добавлять несколько 
обработчиков разных событий. 
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Все файлы, необходимые для выполнения данной работы, находятся на раздаточном диске в 
папке «lesson_06\Practice_Work_6» ( включая примеры выполненных заданий).

Для выполнения данной практической работы, рассчитанной на изучение языка программи-
рования  ActionScript  2.0, Вам понадобятся ранее созданные ролики. В них не должны быть 
использованы �D-�ффекты и �ффекты обратной кинематики (Для этих эффектов требуется 
ActionScript  3.0). 

Если ролик не использует данных �ффектов, то убедитесь, что в настройках публикации  
«File > Publishing Settings» на закладке «Flash» в списке «Script» выбрана нужная версия  
языка «ActionScript  2.0»

Задание 1. ActionScript  2.0. Создание кнопок, команды «play» и «stop»

1.  Откройте любой ранее созданный анимированный ролик.

2.  Добавьте новый слой и назовите его «actions». Чтобы анимация не начиналась сразу же в 
первый кадр данного слоя добавить скрипт: stop();
�.  Создайте кнопки «play» и «pause» и присвойте им имена �кземпляров Instance Name  
(палитра Properties): b_play и b_pause соответственно.

4.  В первый кадр слоя «actions» добавьте обработчик событий мыши для данных кнопок:
 b_play.onRelease = function() {
  play(); 
 }
 b_pause.onRelease = function() {
  stop(); 

 }

5.  Чтобы анимация не останавливалась, пройдя один цикл, в последнем кадре слоя «actions» 
создайте ключевой кадр и добавьте к нему скрипт: gotoAndPlay(2);

Задание 2. ActionScript 2.0. Команды управления временной шкалой

1.  Откройте файл «02_start.fla». 

2.  В слое «buttons» в первом кадре находятся три изображения различных мониторов в вы-
ключенном состоянии. В библиотеке расположены графические изображения включенных 
мониторов.  Необходимо преобразовать каждый «монитор» в отдельную кнопку так, чтобы 
изначально «монитор» был выключен, а при наведении мыши «включался». Для �того внутри 
каждой кнопки нужно в кадр Up поместить изображение выключенного монитора, а в кадр 
Over - включенного (изображения должны быть выровнены между собой, но изображения вы-
ключенных мониторов лучше не сдвигать, так при �том сместятся маски, которые уже находят-
ся в слое «mask»).

�.  Выше всех слоев добавьте новый слой и назовите его «actions». 

4.  Первому кадру слоя «actions» назначьте метку: start (палитра Properties).

5.  В слое «actions» создайте ключевые кадры (F6) в 10-м, 20-м и �0-м кадрах. И присвойте им 
соответствующие метки: m1, m2, m3.
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6.  Ниже слоя «mask» создайте новый слой и назовите его «small_pict». 

В нем создайте ключевые кадры в 10-м, 20-м и �0-м кадрах и разместите в каждом кадре  
соответствующее изображение из библиотеки: pict_01.png, pict_02.png и pict_03.png (в каждом  
ключевом кадре должно быть только одно изображение).

7.  Измените тип слоя «mask» так, чтобы он стал маскирующим слоем для слоя «small_pict». 
Подправьте положения изображения, чтобы на мониторе отображался желаемый фрагмент.

8.  Выше слоя «border» создайте новый слой – «pict». В �тот слой нужно скопировать ключевые 
кадры из слоя «small_pict». В каждом кадре уже содержится нужное изображение, остается 
только выровнять его относительно рамки, нарисованной в слое «border».

9.  В слое «pict» преобразуйте каждое изображение в клип (Movie clip) и создайте в ключевых 
кадрах (10-м, 20-м и �0-м кадрах) анимацию движения (Create Motion T�een) для �тих клипов. 
В начале анимации (10, 20 и �0 кадры) изображения находятся левее области ролика и к ним 
применен фильтр Blur (размытие) по оси �. В конце каждой анимации (19, 29 и �9 кадры) изоб-�. В конце каждой анимации (19, 29 и �9 кадры) изоб-. В конце каждой анимации (19, 29 и �9 кадры) изоб-
ражение находится в центре ролика, точно попадая в серую рамку (слой «border»)

10. И только теперь ролик готов к тому, чтобы в него добавили сценарии ActionScript.  
Чтобы анимация не начиналась сразу, в первый кадр слоя «actions» добавьте код: 
 stop();

11.  Чтобы после появления нужного изображения ролик самопроизвольно не переходил к сле-
дующему изображения, добавьте в слой «actions» ключевые кадры в 19-й, 29-й и �9-й кадры.  
Для каждого из �тих кадров также пропишите код: 
 stop();

12. Каждой кнопке необходимо присвоить имя �кземпляра Instance Name (палитра  
Properties): b1, b2 и b� соответственно.

1�.  В первый кадр слоя «actions» добавите обработчики событий для кнопок:
 b1.onRelease = function() {
  gotoAndPlay("m1");
 }
 b2.onRelease = function() {
  gotoAndPlay("m2");
 }
 b3.onRelease = function() {
  gotoAndPlay("m3");
 }

Задание 3. ActionScript 2.0. Создание баннера

1.  Откройте любой ранее сделанный анимированный ролик. 

2.  Добавьте новый слой, разместите его выше других слоев и назвите «button». В данном слое 
нарисуйте прозрачную кнопку, закрывающую всю площадь баннера.

�.  Выделите в рабочей области кнопку и присвойте имя �кземпляра Instance Name: b_Link.

4.  К первому кадру слоя «button» добавьте следующий скрипт: 
 b_Link.onRelease = function(){
  getURL("http://имя Интернет-ресурса", "_blank");
 }



Продолжительность 180 минут

Темы занятия:

Занятие 7

1. Импорт из других приложений

2. Создание презентаций

3. Особенности работы с текстом
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Тема 1. Импорт из других приложений

Импорт изображений

Чтобы импортировать растровое и векторное  изображение во fl ash-ролик, необходимо выпол-flash-ролик, необходимо выпол--ролик, необходимо выпол-
нить одну из следующий команд:

File > Import > Import to Stage•  (Импортировать в рабочую область ролика)
File > Import > Import to Library•  (Импортировать в �иблиотеку ролика)

Или просто перетащить нужный файл из файлового менеджера в рабочую область ролика или 
�иблиотеку.

Разница между командами импортирования заключается в том, что команда Import to Stage  
сразу размещает �кземпляр изображения  в рабочей области ролика, а команда Import to Li- to Li-to Li- Li-Li-
brary помещает изображении только в библиотеку.
Все импортированные растровые изображения обязательно попадают в Библиотеку ролика. 

Также можно вставлять изображения из буфера обмена (Edit > Paste in Center - горячая  
клавиша CTRL+V). Настроить опции вставки из буфера можно с помощью команды  
Edit > Preferences на вкладке Clipboard.

Импорт растровых изображений

Импортировать можно изображений следующих форматов:  PNG, BMP, GIF, JPG, TIFF

Особенности импорта:
Формат • PNG поддерживает полупрозрачность – при импорте она сохраняется.  
При импортировании в �иблиотеку автоматически создается графический символ (Graph-Graph-
ic), в котором размещается �кземпляр изображения.

Формат • GIF поддерживает прозрачность и анимацию – при импорте прозрачность 
сохраняется, а анимированные GIF-файлы импортируются как серия изображений. 
 

При импортировании в рабочую область каждое изображение помещается в ключе-
вой кадр так, чтобы сохранить анимацию. Если у кадра была установлена задержка 
воспроизведения, то к нему добавляется нужное количество промежуточных кадров. 
 

При импортировании в �иблиотеку автоматически создается клип (Movie Clip), внутрь ко-Movie Clip), внутрь ко- Clip), внутрь ко-Clip), внутрь ко-), внутрь ко-
торого помещается анимация GIF-файла.

Формат • TIFF поддерживает слои и различные цветовые модели – при импортировании 
все слои склеиваются и полупрозрачность при �том теряется (Flatten). Если в файле была 
использована цветовая модель CMYK – цвета будут отображаться неверно.

Настройка сжатия

Для каждого импортированного в ролик растрового изображения можно настроить индивиду-
альные параметры сжатия. Для �того нужно в палитре Library (�иблиотека) отредактировать 
параметры данного изображения. Окно редактирования параметров открываться либо двой-
ным щелчком по Preview изображение (предварительный просмотр), либо по кнопки Properties, 
расположенной в низу Библиотеке и контекстном меню выделенного ресурса.
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Для растровых изображений можно настроить следующие параметры:
Allow Smoothing•  – Включить сглаживание
Compression•  – Тип компрессии (сжатия)

 Photo (JPEG) – с потерями
 Lossless (PNG/GIF) – без потерь качества

Если изображение было импортировано, как JPEG файл, то доступны параметры:
Use imported JPEG data•  (Использовать импортированные настройки качества)
Custom•  (настроить сжатия)

Для всех других растровых изображений, будет доступны параметры:
Use Publishing Settings • (Использовать настройка публикации)
Custom•  (настроить сжатия)

Можно настроить сжатия для данного файла, или установить единые настройки в парамет-
рах публикации для всех растровых изображений импортированных НЕ как JPEG-файлы.  
Чтобы задать настройки публикации нужно выполнить команду File > Publishing Setting и  
на вкладке Flash в секции Images and Sounds:

установить нужную степень сжатия • JPEG quality
Enable JPEG deblocking•  позволяет смягчить JPEG-артефакты (проблемы, возникающие при 
сильном сжатии изображения)

Программа Flash не очень хорошо применяет JPEG-компрессию. Чтобы получить опти-
мальный баланс между объемом файла и качеством изображения лучше сжимать файлы 
в программе Adobe Photoshop (команда Save for Web & Devices), внедрять их во Flash в виде  
JPEG-файлов и сохранять импортированные настройки качества (Use imported JPEG data).

Обновление и замена файлов

Если растровые файлы были изменены, после того как Вы импортировали из в ролик, чтобы 
обновить их, необходимо в палитре Library (�иблиотека) выбрать все нужные файлы и вы-
полнить контекстную команды Update (Обновить). При этом программа Flash будет искать 
файлы по тому пути, как они были импортированы в ролик.

В окне Properties (Свойства ресурса) палитры Library можно обновить (Update) или заменить 
(Import)  выбранный файл, указав новый путь к файлу.

Также можно заменить эталоны растровых изображений. При �том все свойства �кземпляра 
(положение, трансформация) останутся, но будут применены к новому изображению. 

Для �того нужно выделить �кземпляр изображения и на палитре Properties (Инспектор свойств) 
нажать кнопку Swap (Заменить). После чего в открывшемся списке необходимо выбрать новое 
изображения (новый �талон).

Импорт макетов из PSD-файлов

Вы может создать макет в программе Adobe Photoshop, расположив в нем все растровые �ле-
менты так, так они должны отображаться в ролике. 

При импортировании PSD-файла будет выведено следующее диалоговое окно:
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Вы можете выделять каждый слой, управлять тем будет ли слой импортирован и настраивать 
для него опции импорта. Если выделено несколько слоев их можно свести (Merge Layers).

Слои можно конвертировать в:
Flash Layers•  (Слои flash-ролика)
�e��ra�es•  (Ключевые кадры)

Внизу диалогового окна доступны дополнительные опции (только при импортировании  
командой Import to Stage – горячая клавиша CTRL+R):

Place layers to original position•  – Сохранять позиции слоев
Set stage size to same sixe as Photoshop canvas•  – Установить размер рабочей области как 
размер холста PSD-файла 

Настроить значения опций импорта по умолчанию можно с помощью команды  
Edit > Preferences на вкладке PSD File Importer:

Растровые слои (image layers) можно импортировать как:
Bit�ap images with editable layer style•  – содержимое слоя и �ффекты слоя будут внедрены как 
два разных растровых изображения
Flatted bitmap images•  – содержимое слоя и �ффекты будут объединены в одно изображение

Текстовые слои (text layers) можно импортировать как:
Editable text•  – редактируемый текст
Vector outline•  – векторные контура
Flatted bitmap images•  – растровое изображение

Слои векторных форм (shape layers) можно импортировать как:
Editable paths and layer style•  – редактируемый векторный контур и отдельные �ффекты слоя
Flatted bitmap images•  – растровое изображение

Импортировать/
не импортировать слой

Опции импорта
выделенного слоя
(группы слоев)

Дополнительные опции

Свести выделенные
слои

СПИСОК СЛОЕВ

Конвертация слоев
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Каждый слой можно поместить в клип, установив галочку Create Movie clip, и указав для него 
положение точки регистрации.
Для растровых изображений можно настроить параметры сжатия (Publishing Settings)

Если в PS�-файле содержались маски – слой будет внедрятся с примененной маской с сохра-PS�-файле содержались маски – слой будет внедрятся с примененной маской с сохра--файле содержались маски – слой будет внедрятся с примененной маской с сохра-
нением полупрозрачности. Слои векторных фигур (shape layers) могут быть преобразованы в 
редактируемые векторные контура, а пути (paths) игнорируются.

Импорт макетов из AI-файлов

Макет ролика можно создать в программе Adobe Illustrator. Flash взаимодействует с �тим 
приложением наиболее тесно. Вы можете создавать непосредственно в программе Illustrator  
графические символы и клипы и настраивать их параметры.

При импортировании AI-файла будет выведено диалоговое окно, аналогичное тому, что  
открывается при импортировании PSD-файлов.

Вы можете выделять каждый слой и контур слоя, управлять тем будет ли �тот �лемент импор-
тирован и настраивать для него опции импорта. 

Слои можно конвертировать в:
Flash Layers•  (Слои flash-ролика)
�e��ra�es • (Ключевые кадры)
Single Flash layer • (Единый слой flash-ролика)

Внизу диалогового окна доступны дополнительные опции (только при импортировании ко-
мандой Import to Stage – горячая клавиша CTRL+R):

Place layers to original position•  – Сохранять позиции слоев
Set stage size to same size as I��ustrator artboard • – Установить размер рабочей область под 
размер иллюстрации AI-файла 
I�port unused symbol•  – Импортировать неиспользуемые символы (символы библиотеки,  
которые не размещены в области иллюстрации)
I�port as a single bitmap image•  – Импортировать как единое растровое изображение.

Настроить значения опций импорта по умолчанию можно с помощью команды  
Edit > Preferences на вкладке AI File Importer:

Общие настройки (General)
Show import dialog box•  - Показывать при импорте диалоговое окно
Exclude object outside artboard • - Отрезать объекты расположенные вне границ иллюстрации
I�port hidden layer•  - Импортировать скрытые (не видимые) слои

Текстовые слои (text layers) можно импортировать как:
Editable text•  – редактируемый текст
Vector outline • – векторные контура
Bit�aps•  – растровое изображение

Векторные контура (paths) можно импортировать как:
Editable paths•  – редактируемый векторный контур
Bit�aps•  – растровое изображение
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Для изображений (Images) можно установить параметр:
Flatten bitmaps to maintain appearance•  - Сохранять параметры представления

Группы (Group) и слои (Layers) можно внедрять как растровые изображения -  
I�port as Bit�ap.

Каждый элемент можно поместить в клип, установив галочку Create Movie clip, и указав для 
него положение точки регистрации.

Импорт файлов из CorelDraw

Редактор Flash не может непосредственно импортировать файлы, созданные в приложении  
CorelDra�. Однако CorelDraw может экспортировать swf-файлы. При �кспортировании не-
обходимо задать соответствующие настройки. Полученные s��-файлы могут быть внедрены во 
flash-ролик с помощью команд импорта Import to Stage и Import to Library.

Импорт аудио-файлов и работа со звуком

Чтобы внедрить аудио-файл внутрь fl ash-ролика нужно либо выполнить одну из команд импор-flash-ролика нужно либо выполнить одну из команд импор--ролика нужно либо выполнить одну из команд импор-
та (Import to Stage и Import to Library) либо просто перетащить нужный файл в рабочую 
область ролика или �иблиотеку. 

В отличие от графических изображений аудио-файлы импортируются только в Библиотеку. 
Сразу разместить копию аудио-файла в ролике нельзя.

Для ОС Windo�s Поддерживаются следующие форматы аудио-файлов:
MP� • 
WAV• 
ASND (собственный звуковой формат Adobe Soundbooth)• 

Если в системе установлен QuickTime 4 или более поздней версии, то дополнительно доступны 
форматы AIFF и Sun AU.

Чтобы добавить звук в ролик, его нужно связать с каким-либо ключевым кадром временной 
шкалы. Обычно для размещения звуков создают отдельный слой, чтобы они не смешивались с 
графическими объектами ролика. 

Для добавления звука необходимо выделить ключевой кадр, с которого должно начаться вос-
произведение звука, а затем:

Либо • перетащить нужный звук из �иблиотеки ролика на рабочую область
Либо на палитре • Properties в секции Sound выбрать звук из списка Name

Типы синхронизации

Чтобы звуковое сопровождение согласовывалось с анимацией ролика во Flash используются 
различные типы синхронизации. Выбрать нужный тип можно на палитре Properties в секции 
Sound в списке Sync (Синхронизация).
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В редакторе Flash поддерживаются следующие типы синхронизации:

Steam (Потоковый звук)
Синхронизуем звук и анимацию для воспроизведения на WEB-сайтах. Если прорисовка кадров 
анимация идет не достаточно быстро – будет производиться их пропуск. Потоковый звук оста-
навливается при остановке воспроизведения SWF-файла. Потоковые звуки не воспроизводятся 
после окончания, занимаемых ими кадров.

 Event (Событийный звук)
Синхронизует звук с возникновением какого-либо события (например, нажатие кнопки). Такой 
звук не связан с количеством занимаемых кадров. Если событие происходит снова, запускается 
втора копия звука, даже если первая еще не закончила воспроизведение. 

Start (Событийный звук)
Отличается от Event только тем, что если звук не закончил воспроизведение, а событие про-Event только тем, что если звук не закончил воспроизведение, а событие про- только тем, что если звук не закончил воспроизведение, а событие про-
изошло еще раз, вторая копия звука не запускается.

Stop – Останавливает выбранный звук

На палитре Properties для каждого звукового фрагмента можно настроить количество повторов 
(Repeat x) или зациклить воспроизведение звука (Loop).

Если в ролике в одно время включено несколько аудио-фрагментов, то при воспроизведение  
ролика они будут накладываться. 

Звуковые эффекты

На палитре Properties для каждого звукового фрагмента можно выбрать звуковой �ффект.  
Отредактировать �ффект можно с помощью кнопки Edit sound envelope (обозначается каранда-
шом). При �то откроется окно редактирования:

Встроенные �ффекты:

Left channel•  
Только левый канал

Right channel•  
Только правый канал

Fade to Right• 

Перемещение в правый канал• 

Fade to Left•  
Перемещение в левый канал

Fade in•  
Увеличение громкости

Fade out•  
Уменьшение громкости  

Custom•  
Пользовательский режим

Список встроенных эффектов

Левый
канал

Обрезать звук

Правый
канал

Stop Sound
Маркеры,
управляющие
громкостью

Play Sound
Zoom in
Zoom out

Масштаб

Seconds
Frames

Единицы
измерения
шкалы
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Настройка сжатия

В настройках публикации (File > Publishing Settings) на вкладке Flash можно установить еди-
ные настройки сжатия для всех аудио-фрагментов, внедренных в ролик. В секции Images and 
Sounds отдельно настраиваются параметры потоковых (Stream) и событийных (Event) звуков. 
Доступ к настройкам – кнопка Set.

Для аудио-фрагментов доступны следующие типы копрессии (Compression):
Disable• . �ез сжатия
ADPCM• , Raw. Применяется для сжатия коротких звуков (нажатие на кнопку)
Mp3• . Самый распространенный режим сжатия
Speech• . Речь

Для mp3 компрессии можно настроить:
Bit rate•  (Частота дискретизации)
Quality•  (Качество – определяет соотношение скорости сжатия и качества звука)

Частота дискретизации:
5 кГц•  Приемлемо только для речи.
11 кГц•  Самое низкое качество, рекомендуемое для коротких музыкальных фрагментов
22 кГц•  Часто применяется для передачи через WEB
44 кГц•  Стандартная частота дискретизации, обеспечивающая звучание 
музыки с качеством компакт-диска

Как и в случае с растровыми изображениями самый оптимальный результат можно полу-
чить сжимая аудио-файлы в специализированных приложениях (например, Adobe Soundbooth) 
и внедряя в ролик файл формата mp3 (сохраняя импортированные параметры сжатия). 

Для каждого �лемента можно индивидуально настроить качество сжатия. Для �того на палитре 
Library необходимо вызвать свойства (Properties) нужного аудио-фрагмента. 

Если аудио-фрагмент был импортирован как MP3-файл, то для него доступен параметр 
Use imported MP3 quality (Использовать импортированные настройки качества).

Если в настройках публикации в секции Images and Sounds установлен параметр  
Override sound settings, то индивидуальные настройки аудио-файлов будут игнорироваться и 
все звуки будут �кспортированы с настройками публикации (Publishing Settings)

Параметр Export device sound в настройках публикации позволяем �кспортировать звуки уст-
ройств.

Обновление аудио-файлов

Чтобы обновить аудио-файлы, их необходимо выделить в палитре Library (�иблиотека) и  
выполнить контекстную команду Update (Обновить).

Если имя файла или путь к нему были изменены, то чтобы обновить выбранный файл нужно 
вызвав его свойства (Properties) и выполнить команду Update (Обновить) или Import (Заме-
нить импортированный файл).
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Практический пример. Создание кнопок со звуком и анимацией

Чтобы аудио-фрагмент начинал или прекращал звучание по определенному событию кнопки  
(наведение мыши или нажатие) звук нужно поместить в соответствующий кадр внутри  
символа-кнопки и задать соответствующий тип синхронизации.

Например, чтобы фрагмент sound.mp3 начинал воспроизведение при наведении на кнопку, и 
останавливался при нажатии на нее нужно сделать следующее:
1.  Внутри символа-кнопки создать новый слой и назвать его «sound». В кадре Over создать клю-
чевой кадр (F6) и на палитре Properties в секции Sound выбрать звук sound.mp3 и установить 
для него тип синхронизации Start. Звук будет воспроизводиться при наведении на кнопку.

2.  В слое «sound» создать в кадре Down создать ключевой кадр. На палитре Properties снова  
выбрать звук sound.mp3 и установить тип синхронизации Stop. Таким образом звук будет  
останавливаться при нажатии на кнопку.

Чтобы добавить к имеющейся кнопке анимацию, которая будет воспроизводиться при наведе-
нии мыши, необходимо в кадре Over выбрать тот, �лемент, который будет анимироваться и кон-
вертировать его в клип (Movie clip). Внутри данного клипа создать анимацию. которая будет  
начинаться при наведении мыши на кнопку. Важно, что в кадре Up данного клипа не должно 
быть, иначе анимация запуститься сразу (до наведения).

Импорт видео

Включить видео файлы в ролик можно двумя принципиально разными способами:
Внедрить видео внутрь flash-ролика• . При �том значительно возрастает объем файла. Как 
правило, внутрь ролика не внедряют видео длительностью более 10 секунд.
Воспроизводить видео из внешнего файла•  с помощью встроенного компонента  
FLVP�a�bac�. Этот путь более гибок и используется в подавляющем большинстве случаев. 
Именно так публикуется большинство видео сюжетов для WEB.

Для воспроизведения компонентом FLVPlayback видео должно быть закодирован в одном из 
форматов Flash Video:

FLV• 
F4V•  (кодек �.264)

Перекодировать видео в данные форматы можно с помощью приложения Adobe �edia En-Adobe �edia En- �edia En-�edia En- En-En-
coder CS4, которое устанавливается вместе с редактором Adobe Flash CS4.

Чтобы поместить в ролик видео нужно выполнить команду File > Import > Import video. При 
�том откроется окно мастера, в котором нужно указать путь к файлу и тип внедрения видео:

Видео файлы могут располагаться:
On you computer•  (На вашем компьютере)
Already deployed to a server•  (На удаленном сервере)

Тип внедрения видео:
Load external video with playback component•  (Воспроизведение из внешнего файла)
Embed FLV in SWF and play in timeline•  (Внедренное видео, только FLV файлы)
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После нажатия кнопки Next для внешнего видео необходимо выбрать вид оболочки проигрыва-
теля (Skin). А для внедренного видео доступны следующие параметры:

Symbol type • (Тип символа, в который будет помещено видео)
Place instance on stage•  (Разместить �кземпляр на рабочей области)
Expand timeline if needed • (При необходимости добавить кадры на временную шкалу)
Inc�ude audio•  (включать аудио-дорожку)

После выбора необходимых параметров видео будет помещено в ролик.

Настройка компонента FLVPlayback

В среде разработки Flash предварительный просмотр видео недоступен. Компонент  
FLVPlayback можно перемещать по рабочей области и трансформировать. Чтобы получить 
доступ к настройкам компонента необходимо открыть палитру Component Inspector. 
На вкладке Parameters доступны следующие свойства компонента:

autoPlay• :  True - видео воспроизводится сразу после загрузки.  
   False - загружается первый кадр и ожидается нажатие кнопки Play. 

autoRewind• : True - видео автоматически перематывает к началу, если достигнут конец 
   видео либо при нажатии кнопки «Stop».  
   False - видео не перематывает. 

autoSize• :  True - размер компонента масштабируется под размера видео.  
   False -  видео масштабируется под размер компонента.

bufferTime• : Количество секунд, которые должны быть буферизованы, прежде  
   чем начнется воспроизведение. 

contentPath• : Путь к видео файлу

isLive• :  Используется только для FMS, передающего поток в реальном времени. 

cuePoints• :  Точки синхронизации 

maintainAspectRatio• : True - видео масштабируется с сохранением пропорций.  
    False - без сохранения пропорций.  
    Результат виден только, если параметр autoSize равен False

skin• :  Оболочка проигрывателя

skinAutoHide• : True - оболочка автоматически скрывается, когда мышь находится  
   вне видео компонента, и появляется при наведении мыши 
   False - оболочка видна всегда

totalTime• :  Общее число секунд в исходного видео 

volume• :  Громкость (%)

Для размещения на WEB-сервере ролика, в который включено воспроизведении видео из вне-WEB-сервере ролика, в который включено воспроизведении видео из вне--сервере ролика, в который включено воспроизведении видео из вне-
шнего файла, необходимо скопировать в одну папку следующие файлы:

SWF-файл ролика • (например, movie.swf)
FLV или F4V видео файл • (например, video.flv)
SWF-файл оболочки компонента • (например, ArcticOverPlayMute.swf)
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Кодирование видео-файлов в форматы FLV и F4V 
c помощью программы Adobe Media Encoder CS4

Приложение Adobe Media Encoder CS4 предназначена для перекодирования видео-форматов. 
С помощью кнопки Add нужно добавить все исходные файлы. Если какой-то файл нужно пере-
кодировать несколько раз с разными настройками, его нужно сдублировать с помощью кнопки 
Duplicate. Удалить файлы – кнопка Remove. 

Программа позволяет составить очередь файлов для перекодирования. После того как очередь 
файлов сформирована, нужно задать выходные настройки файлов. Если нужно применить 
одинаковые настройки для группы файлов – выбираете всю группу и меняете настройки лю-
бого файла из группы. При �том автоматически изменяться соответствующие настройки всех 
остальных файлов группы.
Чтобы начать процесс перекодирования, необходимо нажать кнопку Start Queue.

Настройки выходных файлов:
Format•  – Доступно множество форматов выходных файлов. Для внедрения видео во  
flash-ролики используют форматы FLV | F4V
Preset•  – Качество сжатия. Можно выбирать из списка предопределенных установок или вы-
брать пункт Edit Export Setting – при �том откроется окно настройки выходного файла.
Output fi�e•  – Задет имя и путь к выходному файлу.

Параметры Export Settings форматы FLV | F4V
В левой части окна отображается предварительный просмотр видео и точки синхронизации.
Справа - настройки. Можно перекодировать только видео или только аудио дорожку:

Export Video • (Экспортировать видео)
Export Audio•  (�кспортировать аудио)

Список исходных
файлов

Текущие настройки Текущий файл и процент его перекодирования

Настройки выходных файлов Статус
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Настройки разделены на следующие группы (закладки):
Filters•  (Фильтры) Доступен только фильтр Gaussian Blur (размытие по Гауссу)
Format•  (Формат) Доступны форматы FLV и F4V
Video•  (Настройка видео) 

 Для FLV используется два кодека: 
  - Sorenson Spark (Устаревший кодек – используется для Flash Player 6 и 7)
  - On2 VP6 (Актуальный кодек - используется для Flash Player 8, 9, 10)
 Resize Video – изменить размеры видео
 Frame Rate – частота смены кадров
 Bitrate – частота дискретизации

Audio•  (Звуковая дорожка) Настраивается тип Mono | Stereo и Bitrate
Others•  (Другие) Можно указать реквизиты FTP сервера, куда будут отправлены файлы

Внешний вид окна Export Settings представлен на рисунке:

Работа с XFL файлами

Для улучшения обмена между приложениями Adobe удобно использовать формат �FL.  
Приложения A�ter E��ects и InDisign позволяют �кспортировать файлы �FL, для последующего 
редактирования их в программе Flash. Данные в �FL файлах хранятся в формате �ML.
Открыть �FL-файл можно с помощью команды File > Open.  

Точки синхрониции
(Cue Point)

Управление
предварительным
просмотром

Выходные настройки,
разделенные на группы

Размер
выходного
файла

Область предварительного просмотра Экспортировать видео/аудио
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Имена и настройки слайдов

Все слайды презентация являются экземплярами встроенного класса Screen. По�тому имена 
слайдов должны быть уникальными. Имя слайда обязательно должно начинаться с буквы, зна-
ка «$» (доллар) или «_» (подчеркивания). Далее могут использоваться цифры. Русские буквы в 
именах слайдов допустимы, а пробелы НЕТ.

Для каждого слайда на палитре Properties (Инспектор свойств) можно установить положение 
точки регистрации и включить/отключить параметр Autosnap. Данный параметр не позволяет 
смещаться точке регистрации при добавлении и удалении содержимого слайда.

Параметры презентации

Чтобы получить доступ к параметрам презентации или слайда необходимо выделить нужный 
�лемент на панели навигации и открыть палитру Component Inspector. 
На вкладке Parameters доступны следующие параметры:

autoKeyNav•  (Использование клавиатуры для навигации)
true - при нажатии клавиши «Стрелка вправо» или «Пробел» выполняется переход к сле-
дующему слайду, а при нажатии клавиши «Стрелка влево» выполняется переход к пред-
шествующему слайду
false - клавиатура не используется 

Тема 2. Создание презентаций 

Чтобы разработать презентацию в редакторе Flash при создании нового файла нужно выбрать 
тип Flash Slade Presentation. Программа Flash позволяет создавать презентации со сложной 
иерархической структурой, насыщенные мультимедийными �лементами.

Для презентаций слева отображается 
панель навигации:

Управление слайдами

Изначально презентации содержит только 
один слайд. Добавить слайд можно с помо-
щью кнопки «Плюс» (Insert Screen), располо-
женной в верхней части панели навигации.
Чтобы удалить слайд или группу слайдов, 
их необходимо выделить и нажать кнопку  
«Минус» (Delete screen). 

Изменить порядок следования слайдов мож-
но просто передвигая их с помощью мыши.

Чтобы сделать слайд потомком какого-либо 
другого слайда нужно передвигать его чуть 
правее пиктограммы слайда-родителя. 

Освободить слайд – двигаем его влево, пока 
он не займет нужный уровень иерархии.

Текущий слайд

Слайды-потомки

Родительский слайд

Корневой слайд
Добавить/удалить
Кнопки навигации
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inherit -  слайд наследует данный параметр от своего родителя. Если корневой слайд  
имеет значения inherit, то �то равносильно значению true.

overlayChildren•  (Наложение слайдов потомков)
true – содержимое дочерних слайдов накладывается друг на друга
false - Child 1 удаляется с �крана после появления Child 2

playHidden•  (Воспроизведение скрытых слайдов)
true – если слайд, содержащий анимацию, был скрыт до завершения анимации, то при 
возвращении к данному слайду анимация продолжиться с того кадра, где остановилась. 
false -  анимация слайда начнется снова с первого кадра

autoload•  и contentPath
Данные параметры используются при программной загрузки презентации с помощью 
метода Loader.load().

Особенности корневого слайда презентации

Как правило, в корневой слайд (presentation)  помещают �лементы, общие для всей презента-
ции, такие как фон, кнопки навигации и т.д. Для презентации в целом устанавливают значение 
параметра overlayChildren «true» и тогда �ти �лементы автоматически добавляются ко всем 
слайдам презентации. 

Никакой другой контент в корневой слайд при �том не размещают. Титульный слайд презента-
ции создается отдельно и является первым слайдом презентации (slide1).

Создание кнопок навигации

Adobe Flash не содержит встроенных кнопок навигации для управления презентацией.  
По�тому такие кнопки необходимо создавать самостоятельно. Управление презентацией 
осуществляется с помощью сценариев ActionScript. При работе с презентациями поддержива-
ется только версия ActionScript 2.0.

Для создания кнопок навигации необходимо:

Создать �талоны кнопок и разместить их �кземпляры в корневом слайде презентации.1. 
Присвоить кнопкам имена �кземпляров (Instance name): 2. b_first, b_last, b_next, b_prev
Прописать для соответствующей кнопки скрипт:�. 
Переход к первому кадру:• 

 b_first.onRelease = function (){
  _root.presentation.gotoFirstSlide();
 }

Переход к предыдущему кадру:• 
 b_prev.onRelease = function (){
  _root.presentation.currentSlide.gotoPreviousSlide();
 }

Переход к следующему кадру:• 
 b_next.onRelease = function (){
  _root.presentation.currentSlide.gotoNextSlide();
 } 
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Переход к последнему кадру:• 
 b_last.onRelease = function (){
  _root.presentation.gotoLastSlide();
 }
Важно, что «presentation» - �то имя корневого слайда презентации.

Добавление эффектов перехода между слайдами

Чтобы добавить �ффект перехода нужно выделить слайд и открыть палитру Behaviors  
(Поведения). Нажать на данной палитре кнопку «Плюс» (Add Behaviors) и в раскрывающемся 
списке выбрать пункт Screen > Transition. При �том откроется мастер, а котором можно вы-
брать нужный �ффект перехода и настроить его параметры.

После того, как �ффект перехода добавлен программа Flash автоматически добавит к данному 
слайду необходимый код ActionScript, а �ффект добавится в список на палитре Behaviors. 

Для одного слайда можно добавлять несколько эффектов (например, на появление и скрытие 
слайда). Отредактировать или поменять эффект перехода можно двойным щелчком по соот-
ветствующей строке столбца Action. 

Выбрать событие можно в столбце Event:
reveal•  – Появление слайда
revealChild•  – Один �ффект на появление

      всех слайдов-потомков
hide•  – Скрытие слайда
hideChild•  - Один �ффект на скрытие 

      всех слайдов-потомков

Внедрение анимации и звука в презентацию

Каждый слайд презентации имеет собственную временную шкалу. Анимация слайда воспроиз-
водится циклически. Если необходимо, чтобы анимация слайда воспроизводилась только один 
раз, в последнем кадре анимации нужно создать ключевой кадр и прописать для него скрипт:  
 stop();
Если презентация автоматически должна переходить к следующему слайду (autoplay), то  
к последнему кадру слайду нужно добавить скрипт: 
 _root.presentation.currentSlide.gotoNextSlide();

Чтобы добавить звуковое сопровождение к отдельному слайду презентации, необходимо 
использовать режим синхронизации Stream (Потоковый звук). При �том звук должен зани-
мать столько кадров временной шкалы, сколь длится его воспроизведение. Так как анимация 
(смена кадров) слайда воспроизводиться циклически, то и звук будет автоматически зациклен.  
Чтобы избежать �того к последнему кадру слайду нужно добавить скрипт: 
 stop();

Если для звукового сопровождение слайда используются типы синхронизации Event и Start 
(Событийные звуки), то воспроизведение звука начнется не с указанного кадра данного слайда, 
а с начала всей презентации. Событийные звуки внутри кнопок работают корректно. 

События

Добавить
эффект

перехода

Эффекты
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Тема 3. Особенности работы с текстом 

Работа с текстом во  Flash осуществляется с помощью текстовых полей. Для создания тексто-
вых полей, ввода и редактирования текста предназначен инструмент Text Tool (палитра Tools). 
Редактировать свойства выделенного текстового поля можно с помощью палитры Properties 
(Инспектор свойств). Доступны следующие параметры:

Список Text type (Тип текстового поля)
Static Text•  (Статический текст) Текст может быть изменен только в среде разработки
Dynamic Text • (Динамический текст) Текст может быть изменении с помощью ActionScript
Input Text • (Текст ввода) Пользователь может вводить значения в данное поле

Секция Position and Size (Позиция и размер)
X, Y•  - Положение поля на рабочей область
W, H•  – Размеры текстового поля

Секция Character (Символ)
Family•  – Шрифт
Style•  – Стиль шрифта (нормальный, жирный, курсив и т.д.)
Size•  – Размер шрифта (кегль)
Letter Spacing•  – Интервал между символами
Color•  – Цвет текста
Autokern•  – Автоматический подбор наилучшего интервала между парой символов
Anti-alias•  – Сглаживание
Selectable•  – «Выделяемость» шрифта (Если свойство включено, пользователь может выде-
лить и скопировать текст)

Секция Paragraph (Абзац)
Format•  – Выравнивание текста
Indentation•  – Отступ первой строки
Line spacing•  – Межстрочный интервал
Margins•  – Отступы справа и слева
Orientation•  – Ориентация текста

Секция Options (Опции) - Текстовое поле можно сделать единой ссылкой
URL•  – Ссылка на Интерне-ресурс
Target•  – В каком окне открывать данную ссылку

Секция Filters (Фильтры)
К текстовым полям можно применять любые фильтры, как к �кземплярам символов.

Режимы сглаживания:

Use device font•  (Использовать шрифты устройства)
Обеспечивает наилучшую читаемость мелких текстов.  
Все шрифты приводится к трем стандартным шрифтам устройств: 

    «_sans» (похож на �elvetica или Arial)
    «_seri�» (похож на Times Roman)
    «_type�riter» (похож на Courier)

Bitmap text • (Растровый текст - без сглаживания)
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Anti-alias for animation•  (Сглаживание для анимации)
Хорошо подходит для текстов, использующих крупный шрифт и участвующих в анимации

Anti-alias for readability•  (Сглаживание для читаемости)
Повышает разборчивость текст.

Custom anti-alias (• Заказное сглаживание) Flash Player 8 и выше

Вводя в документ Flash мелкий текст, следует учитывать следующие моменты:
Шрифты без засечек (например, Helvetica или Arial), отображаются четче, чем шрифты • 
с засечками (например, Times Ro�an).
Некоторые стили шрифта (например, полужирный и курсив) могут привести к снижению • 
разборчивости при использовании маленького размера шрифта.
В некоторых случаях текст кажется меньше, чем текст такого же кегля в других прило-• 
жениях.

Статические текстовые поля во Flash разделяются на однострочные (в правом верхнем углу 
отображается белый кружок) и многострочные (отображается квадрат). Многострочное 
поле преобразуется в однострочное двойным щелчком по маркеру. А однострочное поле стано-
виться многострочным, если уменьшить его ширину.

Замена отсутствующих шрифтов

При использовании статического текста в SWF-ролик внедряются контура шрифта.  
То есть если у пользователя не установлен какой-либо используемый шрифт, то несмотря на �то 
текст будет отображаться корректно.

Если вы открывает для редактирования FLA-файл, в котором использованы шрифты, не уста-
новленные на данном компьютере, то автоматически появиться окно Font Mapping (Замена 
отсутствующих шрифтов). В нем можно настроить заменяющий шрифт, которым будет отобра-
жаться текст на данном компьютере.  

При �том если Вы измените любые параметры текстового поля, кроме имени шрифта, то на 
компьютере, где установлен исходный шрифт – текст будет отображаться именно им.
То есть шрифт замены не удаляет информацию об исходном шрифте.

Типы статических
текстовых полей

Варианты ориентации текста

Включен параметр Rotate (Вращение)



Цент компьютерного обучения при МГТУ им. Н.Э. Баумана Adobe Flash CS4. Уровень 1

90 Практическая работа

Практическая работа

Все файлы, необходимые для выполнения данной работы, находятся на раздаточном диске в 
папке «lesson_07\Practice_Work_7»

Задание 1. Создание презентации

1.  Откройте файл 01_start.fla. На основе данного файла создайте свою презентацию. 

2.  Добавьте нужное количество слайдов, к некоторым слайдам добавите «слайды-потомки» и 
примените разные режимы наложения потомков.

�.  Добавите �ффекты перехода между слайдами (палитра Behaviors > Add Behaviors > Screen >  
Transition). C помощью мастера выберите нужный �ффект перехода и настройте его параметры. 

4.  Внутрь некоторых слайдов добавите анимацию. Чтобы �та анимация не воспроизводилась 
множество раз, в последнем кадре необходимо добавить код ActionScript:
 stop();

5.  Добавите к презентации звуковое сопровождение.

6.  При желании сделайте для кнопок навигации между слайдами анимацию, при наведении 
мыши и добавьте к ним звуковой �ффект.

Пример выполненного задания: 01_sample.swf



Продолжительность 180 минут

Темы занятия:

Занятие 8

1. Публикация и экспорт flash-роликов

2. Создания независимых приложений

3. Внедрение flash-роликов в HTML

4. Создания роликов для мобильных устройств



Цент компьютерного обучения при МГТУ им. Н.Э. Баумана Adobe Flash CS4. Уровень 1

92 Публикация и экспорт flash-роликов

Тема 1. Публикация и экспорт flash-роликов

Воспроизведение flash-ролика

Flash-ролики могут быть воспроизведены:
•  В Интернет-браузерах с установленным плагином Adobe Flash Player или Active� Flash.
•  С помощью приложения Adobe Flash Player.
•  С помощью программ Flash �tra в продуктах Director и Author�are корпорации Adobe�.
•  С помощью �лемента управления Active� Flash в Microso�t O�fice и других приложениях с 
поддержкой Active�.
•  В составе фильма Quic�Time.
•  В качестве автономного приложения, которое называется проектором.

Экспорт flash-ролика

Вы можете �кспортировать единичный кадр или весь ролик целиком. 

С помощью команды File > Export > Export Image можно �кспортировать текущий кадр  
flash-ролика. При �том доступны следующие форматы: 
 SWF, EMF, WMF, AI, BMP, JPG, GIF, PNG

Команда File > Export > Export Movie позволяет �кспортировать весь ролик. 
При �том доступны следующие форматы:

SWF (не отличается от SWF-файла полученного с помощью команды Control > Test Movie)• 
AVI, MOV (будут �кспортированы видео-файлы)• 
Animated GIF (будет �кспортированы анимированный GIF-файл)• 
WAV (будет �кспортированы только звуки ролика)• 
EMF, WMF, BMP, JPG, GIF, PNG Sequence (будет �кспортирована последовательность  • 
файлов, в каждом из которых будет находиться одни кадр ролика)

Настройки публикации

Доступ к настройкам публикации можно получить с помощью команды  
File > Publishing Settings (горячие клавиши CTRL+SHIFT+F12). 

Для удобства работы настройки публикации можно сохранять в профили. В верхней части окна 
находится список Current profile (Текущий профиль) и кнопки управления профилями.

На вкладке Formats необходимо отметить галочками все типы файлов, в которые будет произ-
ведена публикация ролика. Доступны следующие типы файлов:

Flash (s��-ролик)• 
�TML (html-страница)• 
GIF, JPEG, PNG Image (альтернативные изображения)• 
Windo�s, Macintosh Projector (независимые приложения)• 

Для каждого типа публикации можно задать имя файла и путь к нему (столбец File).
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Кнопка Use Default Names возвращает �ти значения к настройкам по умолчанию. При �том все 
публикуемые файлы получают имя, как у FLA-файла, и помещаются в туже директорию.

Для каждого выбранного типа публикации открывается собственная вкладка для задания на-
строек публикации.

Настройки публикации SWF-файлов 

Для SWF файлов на вкладке FLAS� доступны следующие настройки:

Player•  – Версия плеера
Script•  – Версия языка ActionScript

Секция Images and Sounds - Определяет настройки сжатия внедренных в ролик растровых 
изображений и аудио файлов (рассмотрены на Занятии 7)
Секция SWF Settings

Compress movie•  – Сжатие ролика. Медиа-файлы, как правило, вставляются в уже сжатом 
виде. По�тому данная настройка дает заметный результат, только если в ролике содержится 
много текстов или скриптов ActionScript
Inc�ude hidden layers•  – Включать скрытые (не видимые) слои
Inc�ude XMP metadata•  – Включать матаданные
Export SWC (только для ActionScript 3.0)•  – Экспортировать файлы компонентов

Секция Advanced 
Generate size report•  – Сгенерировать отчет о размере �лементов ролика
Protect from import • – Защитить от импорта (необходимо будет ввести пароль)
Omit trace action • – Пропустить отладочный вывод
Permit debugging•  – Разрешить удаленную отладку ролика (необходимо ввести пароль)
Password•  – Пароль (только при включении опций Protect �rom import или Permit debugging)
Local playback security•  – �езопасность при локальном воспроизведении:

 - Access local file only – Доступ только к локальным файлам
 - Access net�or� only –Доступ только к сетевым ресурсам

�ard�are Acceleration – Аппаратное ускорение:• 
 - None – Отключено
 - Level 1 – Direct (Прямое)
 - Level 2 – GPU (Графический процессор)

Script time limit•  – Время, через которое прекратиться выполнение скрипта при «зависании». 

После того, как все установлены настройки для публикации файлов нужно нажать кнопку 
Publish, расположенную в нижней части окна. Если нажать кнопку OK, то настройки будут 
просто сохранены. Опубликовать файлы с текущими настройками публикации можно с  
помощью команды File > Publish (горячая клавиша SHIFT+F12).

При подготовки flash-ролика для WEB часто используют альтернативные изображения. 
Эти изображения могут отображаются в браузере вместо flash-ролика, если у пользователя не 
установлен Flash Player. Альтернативные изображения могут быть созданы в следующих фор-Flash Player. Альтернативные изображения могут быть созданы в следующих фор- Player. Альтернативные изображения могут быть созданы в следующих фор-Player. Альтернативные изображения могут быть созданы в следующих фор-. Альтернативные изображения могут быть созданы в следующих фор-
матах: GIF, JPEG, PNG. Для формата GIF можно выбрать тип: анимированный или статичный.  
Настройки данных форматов не отличаются от аналогичных настроек большинства  
растровых редакторов. 
В качестве альтернативного изображения будет опубликован текущий кадр ролика. 
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Тема 2. Создания независимых приложений

При создании независимых приложений Windows и Macintosh Projector программа Flash пуб-Flash пуб- пуб-
ликует файл, в котором содержится как сам контент ролика, так и Flash Player нужной версии. 

В ОС Windo�s файл независимого приложения имеет расширение EXE и его объем примерно 
на 4 Мб превышает объем SWF-файла (эти 4 Мб как раз и занимает Flash Player).

Используя независимые приложения, Вам не нужно беспокоиться, что у пользователя не уста-
новлен Flash Player или установлена старая версия плеера. Обычно независимые приложения 
используются для публикации flash-роликов, распространяемых на CD/DVD дисках, например, 
flash-презентаций.

Для публикации независимого приложения нужно в настройках публикации на вкладке For-
mat отметить тип файла: Windows Projector или Macintosh Projector. Дополнительных на-
строек не требуется. После публикации ролика (Publish) в указанной директории будет создано 
независимое приложение.

Работа в полноэкранном режиме

Flash-ролик может демонстрироваться в полно�кранном режиме. При �том окно Flash Player 
полностью скрывается и остается только контент ролика. Такой режим доступен для роликов, 
опубликованных как SWF или EXE файлы.

Для взаимодействия с Flash Player используются функцию fscommand(), которая позволяет 
передавать из flash-ролика управляющие команды плееру. 

Результат применения fscommand() НЕ отображается в среде разработки Flash, то есть при 
выполнение команды Contorl > Test movie (CTRL+ENTER). Зато при открытии созданного SWF 
или E�E файла файловым менеджером Вы увидите результат применения данных функций.

Чтобы ролик работал в полно�кранном режиме необходимо в первый кадр верхнего слоя про-
писать следующую функцию:
 fscommand("fullscreen", "true");

Иногда также используют функцию, позволяющую сократить список контекстных команд:
 fscommand("showmenu", "false");

Закрыть ролик, демонстрирующийся в полно�кранном режиме можно либо с помощью горя-
чих клавиш ALT+F4, либо нажав клавишу ESCAPE – при �том Flash Player перейдет в нормаль-Flash Player перейдет в нормаль- Player перейдет в нормаль-Player перейдет в нормаль- перейдет в нормаль-
ный режим воспроизведения. 

Можно создать в ролике кнопку, которая будет закрывать окно плеера. Для �то нужно:
1.  Создать �талон кнопки, разместить его �кземпляр в рабочей области ролика и присвоить ему 
имя �кземпляра (Instance Name): b_close
2.  В кадре скриптов (первый кадр верхнего слоя) дописать следующий код:
 b_close.onRelease = function() {
  fscommand("quit"); 
 }
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Публикация AIR-приложений

Adobe AIR – �то новая технология, позволяющая создавать кросс-платформенные приложения, 
которые могут взаимодействовать, как с ресурсами локального компьютера, так и с Интернет-
ресурсами.

Для работы с AIR приложениями нужно установить плеер Adobe AIR (распространяется 
бесплатно). Каждое AIR-приложение также требует инсталляции. После установки приложение 
отображается в списке программ компьютера. 

Чтобы опубликовать flash-ролик, как AIR-приложение, нужно в настройках публикации 
на вкладке Flash в списке Player выбрать Adobe AIR 1.1. Для настройки дополнительных 
параметров необходимо нажать кнопку Settings, расположенныю справа.

Доступны следующие параметры:
File name•  – Имя приложения, которое отображается в списке программ
Name•  – Имя приложения, которое отображается в строке заголовка окна приложения
Version•  – Версия приложения
I�•  – Файлы с разными именами, но одним ID считаются ОДНИМ приложением
Description•  - Описание
Copyright•  – Авторское право
Window style•  – Тип окна приложения

 - System chrome – Стандартное окно
 - System chrome (opaque) – Рамка окна не отображается, а фоновый цвет отображается
 - System chrome (transparent) – Отображается только контент ролика (прозрачное окно)

Icon•  – Приложению можно добавить значок (иконку)
Advanced•  – Расширенные настройки позиции и размера окна
Digital signature•  – Цифровой сертификат

Чтобы опубликовать любое AIR-приложение Вы должны получить или создать цифровой 
сертификат. Один сертификат можно использовать для публикации многих AIR-приложений.
Кнопка Change дает доступ к окну управления цифровыми сертификатами. Кнопка Browse 
позволяет указать путь к сертификату. При �том необходимо указать пароль сертификата. Если 
у Вас нет сертификата, его можно сгенерировать с помощью кнопки Create. 

Destination•  – Имя файла и путь к нему
Inc�uded fi�es•  – Список включаемых файлов

Для публикации AIR-приложения нужно нажать кнопку Publish AIR File.
 

При �том в указанной директории будет сгенерирован файл с расширением AIR. Двойной 
щелчок по данному файлу вызовет диалог инсталляции данного AIR-приложения. 

Если приложение уже установлено, двойной щелчок по его исходному AIR-файлу вызовет 
диалог деинсталляции или замены приложения, если файл содержит более свежую версию 
приложения.
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Тема 3. Внедрение flash-роликов в HTML

Программа Flash может создать html-страницу, в которую будут включены все теги, необходи-Flash может создать html-страницу, в которую будут включены все теги, необходи- может создать html-страницу, в которую будут включены все теги, необходи-html-страницу, в которую будут включены все теги, необходи--страницу, в которую будут включены все теги, необходи-
мые для размещения flash-ролика. Для публикации html-страницы необходимо в настройках 
публикации ролика на вкладке Format выбрать пункт  HTML и настроить параметры на одно-
именной вкладке.

Доступны следующие параметры:
Template•  – Шаблоны публикации. Определяют, какие дополнительные данные будут вклю-
чены в �TML-страницу. В большинстве случаев используется шаблон Flash Only.

Detect Flash Version•  – Определение версии Flash Player. Если на компьютере пользователя 
установлена более старая версия плеера, будет автоматически выведено диалоговое окно с 
предложение обновить Flash Player.

Dimension•  – Размер окна воспроизведения ролика  
Задает значения атрибутов �idth и height для тегов <object> и <embed>

 - Match Movie – По размеру ролика
 - Pixel – Задать размер в пикселях 
 - Percent – Задать размер в процентах

Playback•  – Опции воспроизведения
 - Paused at start – Ролик будет оставаться на первом кадре, пока не будет нажата кнопка  
   «Play» Flash-плеера 
 - Loop – Зацикленная анимация
 - Display menu – Показывать полное контекстное меню
 - Device font – Использовать шрифты устройств

Quality•  – Качество прорисовки ролика

Window mode • – Режим окна ролика

HTML Alignment•  – Выравнивание окна воспроизведения ролика, относительно �TML-
страницы

 - Default - По умолчанию – лево верх
 - Left – Левый край
 - Right – Правый край
 - Top – Верх страницы
 - Botto� – Низ страниц

Scale•  – Масштабирование ролика при изменении размеров окна воспроизведения

Flash Alignment • – Выравнивание ролика относительно окна воспроизведения

Show warning messages•  – Показывать предупреждающие сообщения при возникновении 
конфликта параметров.

Качество прорисовки ролика (Quality)

При публикации ролика можно задать следующие настройки качества:
Low•  – Сглаживание отключено, максимальная скорость воспроизведения
Auto Low•  – Начинается с отключенным сглаживанием, но если Flash Player определил,  
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что процессор способен выполнять сглаживании, оно будет автоматически включено
Auto High•  – Начинается со включенным сглаживанием, но если частота воспроизведения 
падает ниже заданной, сглаживание отключается.
Medium•  – Применяется некоторое сглаживание
High•  – Сглаживание применяется всегда, но не для растровых изображений
Best•  – Сглаживаются все �лементы ролика

Публикация баннеров

�аннер – �то ролик фиксированного размера. По�тому параметр Dimension (размер окна вос-
произведения) должен иметь значение Match Movie. Позиция на странице (HTML Alignment) 
не важна, т.к. код баннера будет внедрен внутрь готовой �TML-страницы сайта. 

В �том случае �TML код, генерируемый программой Flash, можно сократить до содержимого 
тега <object></object>, находящегося в блоке <noscript></noscript>. Но при �том 
в настройках публикации необходимо отключить параметр Detect Flash Version (определение 
версии плеера, установленного на компьютере пользователя).

При размещении на сайте опубликованные SWF-ролик и �T�L-страницу необходимо разме-SWF-ролик и �T�L-страницу необходимо разме--ролик и �T�L-страницу необходимо разме-�T�L-страницу необходимо разме--страницу необходимо разме-
щать внутри в одной директории.

Создание flash-роликов с прозрачным фоном

За то, в каком окне отображается ролик, отвечает параметр Window mode:
Window•  – Оконный режим. Другое содержимое �TML страницы не может располагаться 
ни над роликом, ни под ним.
Opaque Windowless•  – Непрозрачный безоконной. Задает непрозрачный фон для содержимо-
го ролика.  Другое содержимое �TML страницы может располагаться только над роликом
Transparent Windowless•  – Прозрачный безоконный. Фон ролика становиться прозрачным. 
Другое содержимое �TML страницы может располагать как над роликом, так и под ним.

Таким образом, для создания роликов с прозрачным фоном необходимо параметру  
Window mode установить значение Transparent Windowless.

Создание «резиновых» flash-роликов

Чтобы ролик закрыл всю площадь окна браузера необходимо для параметра Dimension (размер 
окна воспроизведения) установить значение Percent и задать размеры ролика:
 Width 100 %    x   Height 100%

Особенность «резиновых» роликов, заключается в том, что они изменяют свой размер, при 
изменении размера окна браузера. 

Параметр Scale отвечает за то, как будет происходить масштабирование ролика:

Default (Show all)•  – Показать все. Отображается все содержимое ролика - даже то, что 
находиться вне границ рабочей области Stage. При изменении окна браузера ролик пропор-Stage. При изменении окна браузера ролик пропор-. При изменении окна браузера ролик пропор-
ционально масштабируется.



Цент компьютерного обучения при МГТУ им. Н.Э. Баумана Adobe Flash CS4. Уровень 1

98 Внедрение flash-роликов в HTML

No border•  – Без границ. Содержимое ролика вне рабочей области НЕ отображается. При 
изменении окна браузера ролик пропорционально масштабируется так, чтобы вся площадь 
окна была заполнена. Часть ролика может обрезаться. 
Exact fit•  – Строгое соответствие. Содержимое ролика вне рабочей области НЕ отобража-
ется. При изменении окна браузера ролик НЕ пропорционально масштабируется так, чтобы 
вся площадь окна была заполнена.
No scale • – Без масштабирования. Ролик не масштабируется при изменении окна браузера. 
Содержимое ролика вне рабочей области отображается.

Примеры режимов масштабирования «резиновых» flash-роликов:

Если для параметра Dimension заданы размеры Width 100 % x  Height 100%, то можно  
управлять позиционированием ролика относительно окна воспроизведения. Параметр  
Flash Alignment задает выравнивание ролика по горизонтали и вертикали.

Оптимизация ролика

Для роликов, размещаемых в WEB, крайне важно соблюдать баланс между мультимедийной 
насыщенностью, объемом получаемого файла и скоростью воспроизведения ролика.

Для �того необходимо выполнять правила оптимизации роликов:

Для каждого �лемента, который встречается неоднократно, используйте • символы
Если объекты отличаются только цветом, создавайте их как �кземпляры одного символа и • 
настраивайте цвет с помощью параметров Color Effect палитры Properties
Вместо покадровой анимации используйте • Tween-анимацию
Избегайте анимации • растровых изображений. Используйте их только в качестве фона или 
статических �лементов.
Экономно•  применяйте фильтры, поскольку �то замедляет воспроизведение
Внедряйте внутрь ролика • сжатые растровые изображения (JPEG) и аудио файлы (MP�)

Default (Show all) No border Exact fit No scale
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Оптимизация векторных контуров:
Экономно•  используйте специальные типы линий (пунктиры, точки и т.д.). Сплошные 
линии требуют меньше памяти
Линии• , созданные инструментом Карандаш, занимают меньше места, чем мазки Кисти.
Экономно•  используйте градиенты. Градиентная заливка области требует примерно на 50 байт  
больше места, чем заливка сплошным цветом.
Старайтесь • реже использовать �ффект альфа-прозрачности, поскольку �то замедляет 
воспроизведение.
Оптимизируйте количество • опорных точек сложных контуров с помощью команды  
Modify > Shape > Optimize. 

Тема 4. Создания роликов для мобильных  
устройств

Программа Flash может создавать ролики для мобильных устройств. Для �того при создании 
файла необходимо выбрать пункт Flash File (Mobile). Отроется специализированное приложе-
ние Adobe Device Central CS4.

Adobe Device Central - �то программа эмуляции мобильных устройств. Она позволяет выбрать 
целевое устройство и выяснить параметры и ограничения, которые имеются у �того устройс-
тва. �иблиотеки устройств постоянно обновляются.

После выбора нужного устройства необходимо нажать кнопку Create, расположенную в правой 
нижней части окна. При �том будет создан новый flash-ролик, для которого:

Размеры рабочей области•  будут заданы в соответствии с размером �крана устройства
Настройки публикации•  будут установлены в соответствии с возможностями выбранного ус-
тройства (версия Flash-проигрывателя и версия языка ActionScript).

В остальном ролик для мобильных устройств ничем не отличается от других типов роликов. 

При тестировании ролика (Control > Test Movie или CTRL+ENTER) будет открываться прило-
жении Adobe Device Central. Вы сможете не только увидеть, как выглядит Ваш ролик на �кра-
не выбранного устройства, но и контролировать параметры устройства при воспроизведении 
ролика (объем занимаемой памяти и т.д.).

С помощью языка ActionScript можно создавать flash-приложения для мобильных устройств. 
При �муляции в программе  Adobe Device Central будет доступно управление flash-приложением 
с помощью клавиатуры устройства.
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Внешний вид окна приложения Adobe Device Central представлен на рисунке:

С помощью приложения Adobe Device Central также можно �мулировать контент мобильных 
устройств, созданный в программах Adobe Photoshop, Adobe Illustrator и Adobe After Effects. 

Для создания нового документа необходимо в приложении Adobe Device Central выполнить 
команду File > New Document In и выбрать нужное приложение. 

После выбора целевого устройства нужно нажать кнопку Create.  При �том откроется выбран-
ное приложение и в нем будет создан файл, размеры которого будут соответствовать размеру 
�крана устройства. 

Для просмотра эмуляции файла нужно выполнить команду File > Save for Web & Device.  
В нижнем правом углу диалогового окна данной команды находится кнопка Device Central, 
позволяющая перейти в режим �муляции.

Кнопки управления
эмулятором

Emulator (Режим эмуляции)Device Profile (Профиль устройства)

Контролируемый параметры
выбранного устройства

Списки доступных
устройств



Приложения
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Приложение 1. Список горячих клавиш

Сохранить файл   – CTRL+S
Сохранить файл как  – CTRL+SHIFT+S
Закрыть файл   – CTRL+W
Открыть файл   – CTRL+O
Создать новый файл  – CTRL+N
Отменить действие  – CTRL+Z
Вернуть действия   – CTRL+Y

Тестировать ролик  – CTRL+ENTER
Опубликовать ролик  – SHIFT+F12

Настройки публикации - CTRL+SHIFT+F12
Импортировать в ролик - CTRL+R

Скрыть все палитры  – F4
Открыть/закрыть палитру Library (Библиотека)  – CTRL+L
Открыть/закрыть палитру Actions (Действия) – F9
Быстрый ввод команд ActionScript – Escape + быстрые клавиши данной команды
Контекстная справка - F1

Конвертировать в символ – F8
Создание копии объекта – при перетаскивании держим ALT

Вставка промежуточного кадра – F5
Вставка ключевого кадра   – F6
Вставка пустого ключевого кадра – F7

Создание копии кадра – при перетаскивании кадра держим ALT 

Перемещения по один кадр вперед по временной шкале – клавиша «>»
Перемещения по один кадр назад по временной шкале – клавиша «<»

Выделить единичный кадр из диапазона анимации движения и слоя поз обратной 
кинематики – щелчок с нажатой клавишей CTRL

Вызов инструмента Free Transform Tool – Q
Пропорциональная трансформация   – SHIFT
Масштабирование и сдвиг от точки трансформации – ALT

Поворот на 45 градусов и перемещение только вдоль осей координат – SHIFT
Перемещение сразу на 10 px при перемещение объекта с клавиатуры – SHIFT

Временное переключение инструмента Free Transform Tool в режим Distort  – CTRL

Перспективная трансформация с помощью Free Transform Tool – CTRL+SHIFT
(два противоположных угла объекта симметрично сдвигаются навстречу друг другу) 
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Приложение 2. Обозначения временной шкалы

На временной шкале (Timeline) кадры разных типов 
имеют следующие обозначения:

Тип кадра Обозначение
Промежуточный кадр 
(Frame) �ез маркера

Пустой ключевой кадр
(Blan� KeyFrame) Кружок без заливки

Ключевой кадр
(KeyFrame) Кружок с черной заливкой

Конец диапазона видимости 
предыдущего ключевого кадра Вытянутый прямоугольник без заливки

Ключевой кадр свойств
(Property KeyFrame) и кадр поз 
обратной кинематики (Pose)

Ромбик с черной заливкой

Анимация разных типов выделяется цветом:

�елый цвет     -   Пустые кадры (без анимации) 
Серый цвет    -   Покадровая анимация (Frame by Frame)
Светло-зеленый цвет  -   Анимация формы (Shape T�een)
Темно-зеленый цвет   -   Слой поз обратной кинематики (Armature)
Фиолетовый цвет   -   Классическая анимация движения (Classic T�een)
Синий цвет    -   Анимация движения (Motion T�een)
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